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About the InteGrade Pro Software

This section briefly describes the InteGrade® Pro teacher gradebook and 
provides an overview of the system requirements and the data exchange 
process between the InteGrade Pro software and various school 
administration systems.
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Introduction
The InteGrade Pro software is an electronic gradebook used by teachers 
to record, analyze, and report on student performance. The InteGrade Pro 
software can be implemented in a variety of ways including on a stand-
alone PC or over a network. There is also a Web-based version of the 
InteGrade Pro software that provides most of the feature functionality of 
the standard InteGrade Pro software.

The InteGrade Pro and InteGrade Pro Server software version 9.1 can be 
installed regardless of whether you have a previous version of InteGrade 
Pro installed on your system.

The InteGrade Pro software continues to support both Macintosh and 
Windows environments and features fully platform-independent data files. 
You can open and save InteGrade Pro files on any platform, in any 
combination, with no conversion required. Switching platforms preserves 
nearly all features.

When used with an Pearson Digital Learning administration system, the 
InteGrade Pro software can save time and reduce transcription errors. 
Student names, numbers, class lists, and other information transfer from 
an electronic administration system to a teacher's gradebook. You can 
also electronically transfer report card data and End Term spreadsheet 
information from the teacher's gradebook back to the administration 
system for report card preparation.

Teachers can create and update gradebooks manually or by importing 
changed information from the administrative system. During the import 
process, the InteGrade Pro software creates log files in the appropriate 
teacher folder on the administration system. These log files list all records 
rejected during import and are overwritten with each import.

When teachers create gradebooks, the InteGrade Pro software gives them 
the ability to set up a new gradebook with classes and students 
automatically by importing class roster files. After the gradebook is created 
the InteGrade Pro software enables the teacher to enter values on the End 
Term spreadsheets that the administration system may not accept. If the 
user enters such values, the software alerts them to this fact.

http://k12.ncs.com/
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New Features in the InteGrade Pro 9.1 Software
Version 9.1 of the InteGrade Pro software includes the following features:

Users can now choose to send progress reports in plaintext instead of 
HTML.
Enhancements to aid in troubleshooting e-mail problems.
E-mail authentication can now be turned off from the Communications 
tab.
E-mail subject lines now start with the student’s name.
E-mail return paths have been corrected.
Users with Windows XP can now run the InteGrade Pro software even 
if they do not have Administrator or Power User login privileges.
The security of the Master Password Generator has been enhanced.
The InteGrade Pro CIMS converter now runs on Windows XP.
InteGrade Pro Server software data repository has been restructured 
to avoid concurrent access lockups, eliminate data corruption, and 
improve login and access speeds.
InteGrade Pro Server software import processes have added 
safeguards to avoid duplicating teacher entries and unintentionally 
sharing class lists.
InteGrade Pro Link™ now permits the use of Universal Naming 
Convention (UNC) network paths and drives.

Other changes in this version include the following:

Attendance spreadsheet scrolls to current date

When switching to an attendance spreadsheet, it now automatically 
positions the page to show the column with the current date.  In previous 
versions this feature was only available on Macintosh, while in Windows, 
switching to an attendance spreadsheet positioned the view to the first 
attendance day instead of the last.

Collect marks files from server-side gradebooks through Control 
Panel

In previous versions, teachers had to submit marks files by selecting the 
option from within InteGrade Pro.  This often meant that some teachers did 
not submit on time.  With this release, administrators with InteGrade Pro 
Server can generate marks files directly from the gradebooks saved on the 
server.

http://k12.ncs.com/
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Better recovery after save to server fails

When signed into IGPro Server with a gradebook open, trying to save on a 
network disconnect causes IGPro to save your gradebook locally.  When 
IGPro Server is re-launched the local copy can be uploaded.  In previous 
versions, the user also received an error message that InteGrade Pro 
Server cannot open a locally saved gradebook. This has now been 
corrected so that updating a server gradebook under these circumstances 
does not produce an error.

Bonus assignments now print letter grade of N/A

The student progress reports and the email progress reports used to print 
an ‘F’ for low-scoring Bonus tasks. This has been changed to print the 
letter grade for bonus assignments as “N/A”.  

Text fields now support accented characters across platforms

In previous versions, text fields in InteGrade Pro were saved using 
platform-specific ASCII extensions.  This meant an accented character like 
‘Ñ’ saved into a gradebook on Windows did not appear the same when the 
gradebook was loaded on a Macintosh, and vice versa.  In this release, the 
underlying text format follows a common standard and gradebook text 
fields with accented characters appear the same when viewed on both 
Windows and Macintosh.

Removed “How to use help” from the InteGrade Pro Help menu on 
Windows

Previous versions of InteGrade Pro for Windows had a help menu item of 
“How to use help”.  This Windows help topic is not available starting with 
Windows XP, so the associated menu item was removed. 

http://k12.ncs.com/
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InteGrade Pro System Requirements
System requirements vary depending on which components you are 
installing. Be sure to read the InteGrade Pro Readme help file for 
additional requirement information.

InteGrade Pro Requirements

System requirements for InteGrade Pro software have changed with the 
9.1 product update.

These requirements are for users who will use the InteGrade Pro software 
as a stand-alone product as well as for those who will be connecting to the 
InteGrade Pro Server software from a computer at school or at home.

Additional requirements for those who will use the InteGrade Pro Web 
software are listed in a separate section below.

Windows Operating System

Windows® 98 SE, 2000, or Windows XP 
A computer that meets the requirements for the version of Windows 
that you are running 
At least 20 MB available hard disk space (48 MB with scanning tools)
At least 32 MB RAM

Macintosh Operating System

Any Macintosh® with: 

Mac OS® 8.6 or later. Note that InteGrade Pro only runs in Classic 
mode on Mac OS X. For Mac OS 8.6 to Mac OS 9.X you also need the 
Mac OS Runtime for Java (MRJ) 2.2.5 or higher from
http://developer.apple.com/java/download.html. 
At least 20 MB available hard disk space.
At least 32 MB RAM.

http://k12.ncs.com/
http://k12.ncs.com/


About the InteGrade Pro Software

6  InteGrade Pro System Requirements Copyright © 1998–2004 Pearson Digital Learning

InteGrade Pro Server Requirements

To use the file serving functionality of the InteGrade Pro Server software, 
the network server must be Windows-based and meet the following 
specifications:

Windows 2000 Server or Windows 2003 Server network operating 
system.

A computer that meets the requirements for the version of Windows 
that you are running. 

At least 30 MB available hard disk space to accommodate the server 
and Web components.

An additional 3 MB of disk space for each gradebook that will be stored 
on the server. For example if your school has 50 teachers, you will 
need at least an additional 150 MB of storage space for the current 
gradebooks (not including previous years and backup copies).

At least 128 MB RAM.

InteGrade Pro Web Requirements

When you install the InteGrade Pro Server software, the Web server 
functionality is automatically installed on the network server at the same 
time.

Client computers connecting to the InteGrade Pro Server software via the 
InteGrade Pro Web software, must meet the following conditions:

Pearson Digital Learning supports the following Web browsers for use 
with the InteGrade Pro Web software:

Internet Explorer 5.1.7 for Mac OS 8 or OS 9 systems
Internet Explorer 5.2.3 or later for Mac OS X systems
Internet Explorer 5.5 SP2 for Windows 98 SE systems
Internet Explorer 6.0 with SP1 for Windows 2000 and XP systems
Netscape® Navigator 7.02 for Mac OS 9 and Netscape® Navigator 
7.1 for Mac OS X systems 
Safari 1.2 for Mac OS X systems.

Macintosh network servers are not supported. Users that have networks 
with Macintosh servers can still use the InteGrade Pro software, but they 
cannot take advantage of the networking and file management features 
available with the InteGrade Pro Server software.

http://k12.ncs.com/
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The InteGrade Pro Web software may not fully support earlier versions 
of these Web browsers. If remote computers use unsupported 
versions, please ensure that their JavaScript settings are disabled and 
be aware that the formatting of the Web pages might not be optimal.

Connecting computers must have an Internet connection speed of at 
least 28.8 Kbps.
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InteGrade Pro and Administration Systems
InteGrade Pro gradebook software can exchange data with the following 
Pearson Digital Learning administration systems:

SASIxp™ student information software
SASI™ III student administrative software
CIMS® software
The School System™ (TSS) software 
The Elementary School System™ (TESS) software
OSIRIS® student information management software

One of the general requirements for this exchange is to export the 
necessary data from the administration systems to populate InteGrade Pro 
teacher gradebooks with class rosters, attendance calendars, course IDs, 
and so on. Another is to import grades and/or attendance information from 
InteGrade Pro gradebooks into to the administration systems. 

The data exchange feature of the InteGrade Pro software lets you transfer 
data between the administration system and InteGrade Pro gradebook 
software. For example, you can transfer up-to-date information between 
databases without having to manually enter data. You can also transfer 
different types of data such as the following:

Teacher
School information
Student, with demographic information
Class rosters
Grades
Data validation rules
Grade tables

User Work Flow

Beginning of Year

At the beginning of a school year, when the school is establishing its 
master schedule, the administration system creates a class roster file 
(CLxxxxxx.GRD, where xxxxxx represents the teacher code). This file 
contains class and student information and is used to create or update a 
gradebook for a single teacher within a single school. All these files are 

http://k12.ncs.com/
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saved in specific teacher folders. Your administration system may create a 
directory structure allowing these files to be stored separately by district, 
school, and teacher.

At the start of the year, teachers can use either the New Gradebook 
command on the File menu or the Create gradebook command on the 
InteGrade Pro banner screen to create a new gradebook. If a school uses 
an administration system, the InteGrade Pro software automatically 
creates an End Term spreadsheet for designated reporting periods for 
designated classes.

The CLxxxxxx.GRD file specifies the labels for the columns in the End 
Term spreadsheet. These columns represent data such as final grade, 
work habit, comments and so on. End Term spreadsheets collect data for 
report cards or interim reports. Only data from End Term spreadsheets or 
attendance spreadsheets can be sent from the InteGrade Pro software 
back to the administration system.

Teachers who connect to the InteGrade Pro Server software can create 
gradebooks on the server at school and the system automatically looks for 
a class roster file when gradebooks are created or updated.

If necessary, a teacher can use the Import command on the File menu to 
manually import a CLxxxxxx.GRD file. Teachers do this when a school is 
not networked and disks are used to transfer CLxxxxxx.GRD and 
MKxxxxxx.GRD files between the teachers and the administration system.

During the Year

Throughout the reporting period the school's system administrator should 
export new CLxxxxxx.GRD files so that teachers get updated class lists, 
add/drops, and other changes. Some schools with frequently changing 
student populations may need to generate this file as often as once a day. 

The InteGrade Pro software has a feature to automatically find these files 
and update the gradebook so that no additional effort is required by the 
teachers. If this feature is used, each time a teacher opens a gradebook, 
the product checks the teacher's CLxxxxxx.GRD file to see if class rosters 
or other information has changed, and automatically updates the teacher's 
gradebook. These CLxxxxxx.GRD updates never damage teacher data. 
They only update or add to the gradebook.

During the year, the teacher enters tasks (any graded assignment such as 
quizzes, homework, or tests) and attendance, and calculates grades 
throughout the reporting period. 

http://k12.ncs.com/
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End of Reporting Period

The teacher copies final grades to the End Term spreadsheet, along with 
other data, as needed. Some teachers may use other methods for grade 
collection and use the End Term spreadsheet to manually enter grades at 
the end of the reporting period.

When teachers have filled out the End Term spreadsheets for the current 
reporting period for all classes, they use the InteGrade Pro software export 
process to create an MKxxxxxx.GRD file at a specified location. This file 
contains the grades in each of the columns of the End Term spreadsheet. 
The InteGrade Pro software checks for valid data in the End Term 
columns as specified by the administration system in the CLxxxxxx.GRD 
file.

The administration system imports the MKxxxxxx.GRD files into the 
database to update student grades.

System Files
Administration systems export a series of class roster files 
(CLxxxxxx.GRD files). One CLxxxxxx.GRD file creates or updates a 
gradebook for a single teacher within a single school for one or more 
reporting periods. 

Each CLxxxxxx.GRD file contains records that describe all students and 
all classes for that teacher. It also contains the data collection 
requirements and rules that the product interprets to set up End Term 
spreadsheets for that teacher to collect grading information to return to the 
administration system. The administration system can define letter grades 
and other rules that the InteGrade Pro software uses to reduce errors 
when entering end term (report card) data.

The administration system also imports marks data files (MKxxxxxx.GRD) 
created in the InteGrade Pro software that contain report card grading 
information (End Term) for that teacher's students.

The School System (TSS) software release 7.1 and earlier, and Osiris 
software earlier than version 5, use *.GC files instead of *.GRD. TSS 
release 8.0 produces *.GRD files, as does Osiris version 5.

http://k12.ncs.com/
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Folder Hierarchy

The administration system may also automatically create a folder 
hierarchy in which to store CLxxxxxx.GRD files and from which to import 
MKxxxxxx.GRD files. This figure shows an example.

This structure allows files to be stored separately by district, school, and 
teacher. This feature prevents collision of file names for files created for 
the same teacher at different schools within the same database. InteGrade 
Pro requires that each gradebook contain data for only one teacher at only 
one school. The administration system imports MKxxxxxx.GRD files from 
the mandated IGPData directory structure to populate the grading tables in 
its database.

Error log files are also created in the top level IGPData directory. These 
files list all records rejected during a single import of MKxxxxxx.GRD files. 
The InteGrade Pro software creates an error log file named 
ERRORLOG.AMK. This file is overwritten each time there is a new import. 
Users can maintain an archive of the error logs by copying or moving the 
file to a different location before running the import.

The SASIxp software builds files for one school at a time, based on the 
school the user is currently logged into.

The SASI III software does not have the school level of the hierarchy and 
uses IGP_Data as the directory. You need to run igpcl.exe to create the 
entire IGP_Data structure and igpmk.exe to read files from this structure. 

http://k12.ncs.com/
http://k12.ncs.com/


About the InteGrade Pro Software

12  InteGrade Pro and Administration Systems Copyright © 1998–2004 Pearson Digital Learning

End Term Spreadsheet

Each administration system defines one spreadsheet for each class for 
each collection date. For example, in a school that schedules by two 
semesters and four quarters, the administration system may mandate four 
End Term spreadsheets for each class, collecting grade data as follows: 

End Term Spreadsheet 1: Quarter 1
End Term Spreadsheet 2: Quarter 2 and Semester 1
End Term Spreadsheet 3: Quarter 3
End Term Spreadsheet 4: Quarter 4, Semester 2, and final year.

These spreadsheets include columns for specific data collection, for 
example Quarter 1, Semester 1, and Final Year. Each column may be set 
up to contain specific data such as letter grades, comments, and total 
absences. InteGrade Pro gradebook software uses validation rules to 
verify correct data entry for each column. These rules are defined by the 
administration system.

Using Templates to Create Gradebooks

When a user creates a new gradebook, the InteGrade Pro software 
searches for a template gradebook whose contents and option settings will 
be included in the new one. This template file must be named 
template.gbf.

Subsequent imports of administrative data will only overwrite the 
“incomplete” (INC) symbol and grade tables with the same name. All other 
data remains unchanged in the gradebook.

Location of Gradebook Template Files

Template files used by the InteGrade Pro Server software when creating 
users must be stored in one of these folders:

In the same folder as the imported user's class roster file
In the IGPDATA "_Common" folder

Template files used on a client connected to the InteGrade Pro Server 
software must be stored in one of thse folders:

In the same folder as the imported user's class roster file
In the parent folder of the folder containing the user's class roster file
In the IGPDATA "_Common" folder
In the InteGrade Pro software application folder

http://k12.ncs.com/
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Template files used for local and network imports must be stored in one of 
these folders:

In the same folder as the imported user's class roster file
In the parent folder of the folder containing the user's class roster file
In the InteGrade Pro software application folder

Creating a Template Gradebook and Template Classes

Although anyone can create a template gradebook, it is generally the 
system administrator who is responsible for creating the template.

1. Create a new gradebook without importing any class roster files. 

2. Set the options for Display, Grading Rules, and any other standard 
settings required by the teachers who will be using this template. You 
do not need to include students or classes.

3. Add default classes if you want. For example if you want every 
gradebook to have a math and an English class, create default classes 
for each of these. Each time a gradebook is created using the 
template, the gradebook will automatically contain the default classes.

4. Add a template class if you want. You can create a template class that 
includes standard spreadsheets that you want applied to the creation 
of any new classes that are imported. For example, you can create a 
template class labeled “template” and add several spreadsheets to it. 
Then each time a user imports classes from the class roster file using 
the template file, each imported class will have those template 
spreadsheets added to it.

5. Save the gradebook as template.gbf. Be sure to store the gradebook 
in the appropriate location for the type of system being used. See 
Location of Gradebook Template Files.

Data Copied when a Template is Used

All settings of the template gradebook are copied to gradebooks created 
using the template. These settings include:

All display settings.
All grading rules.
Default students. Students added using the template are considered 
manually added unless subsequently imported.
Default classes. Classes added using the template are considered 
manually added unless subsequently imported.

http://k12.ncs.com/
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Any template classes you created.
Report settings.

The following data copied from the template gradebook is overwritten 
upon import:

The “incomplete” symbol
Any grade tables with the same name

Administrative Control Settings

A small separate program named igproadmin.exe is used to set control 
preferences of demographic fields and advanced fields. The program edits 
existing class roster files on the network based on the top-level folder 
choice, and adds an appropriate N580 record.

1. From the \IGPRO folder, double click igpadmin.exe.

2. Select whether you want to control teacher access to advanced fields 
and demographic fields. There is no need to set controls for Type Sets 
if your administrative system does not specify them.

3. Select the top-level folder to begin this operation. Administrative 
control is set on every class roster file in this folder and every folder 
within it.

4. Click Execute.

http://k12.ncs.com/
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An N580 line is added to the end of each class roster file.

Once the control preferences are set within the InteGrade Pro software, 
their state can only be changed by importing another N580 record. Import 
of a new class roster file that contains no N580 will not affect the current 
control preferences.

http://k12.ncs.com/
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InteGrade Pro System Information

Gradebook and Class Roster Data File Names
Files created by the administration system have the prefix CL. Files 
created by InteGrade Pro gradebook software have the prefix MK.

The maximum length of teacher codes within the CLxxxxxx.GRD file name 
is six characters. The .GRD extension is common to both types of prefixes. 

The School System (TSS) software release 7.1 and earlier and Osiris 
software earlier than version 5 use *.GC files instead of *.GRD. TSS 
release 8.0 produces *.GRD files, as does Osiris version 5.

Class roster files created on the IBM® AS/400® or e™Server iSeries 400 
midrange computer system by the CIMS III software are named 
CLdissch.CIM, where dis represents the District ID and sch represents the 
School ID. Marks data files being uploaded from the InteGrade Pro 
software to the CIMS software are named MKdissch.CIM. Note that 
schools must use the CIMS converters to create CLxxxxxx.GRD files (for 
teacher use) from the Cldissch.CIM file and to create the Mkdissch.CIM 
file from MKxxxxxx.GRD files. A single CIM file contains all CL files for all 
teachers.

Mapped Drives

Before you can export when operating in a Windows environment, you 
must map the drive to which you want to export. Refer to your Windows 
operating system documentation for information on mapping drives.

Attendance Codes

This section applies to those who have school administration systems that 
support attendance tracking.

Attendance codes are used to explain why a student is absent. If you 
created a gradebook by importing a class roster file from an administration 
system, you must use the existing system codes, so that the file exports 
correctly.

This table lists the system codes and their late and absent values. These 
codes are used in the Class Attendance report and the Student 
Attendance report where the summaries list Late, Absent, and Present. 
For example, a Tardy and an Excused Tardy both are included in the Late 

http://k12.ncs.com/
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category, and an Excused counts as an Absent. If you create a new 
attendance code, you must assign one of these system codes to it, so that 
those reports are created correctly.

Important System Directories and Files

The _COMMON Directory

All users have read-only access to the _COMMON directory. You can use 
it for storing a single template gradebook that is to be used by all users 
when creating gradebooks. The system administrator can also place files 
to be imported by users (using the File | Import feature in the InteGrade 
Pro software) in this directory. When users log on to the InteGrade Pro 
Server software, they will have access to this directory.

The Data Repository

The InteGrade Pro Server software uses a number of data repository files 
to store all of the server configuration information. The files have a ".dat" 
file extension and are located in the C:\Program Files\NCS 
Pearson\InteGrade Pro Server\Data folder. 

You must not edit these files. They are automatically generated by 
InteGrade Pro Server. 

Code Late  Absent 

Activity 0 0 

Dismissed 0 0.5 

Excused 0 1 

Excused Tardy 1 0 

Not Enrolled 0 0 

Present 0 0 

Suspended 0 1 

Tardy 1 0 

Undefined 0 0 

Unexcused 0 1 

Unexcused Tardy 1 0 

Unverified 0 1 

http://k12.ncs.com/
http://k12.ncs.com/


About the InteGrade Pro Software

18  InteGrade Pro System Information Copyright © 1998–2004 Pearson Digital Learning

Random Password File

The InteGrade Pro software includes a file called passwordparts.txt. This 
text document contains a list of four-letter words that are randomly 
combined during password generation. This file is located in the 
C:\Program Files\NCS Pearson\InteGrade Pro Server\Data folder. 

You must not edit this file.

Server Configuration File

When a client computer is configured to connect to the InteGrade Pro 
Server software, that system maintains a servers.cfg file.

This file contains information for each server added on the Open 
Gradebook screen on the client computer. The following is a sample of the 
information contained in the servers.cfg file.

207.194.137.999:143 Test Server at School 1

216.232.118.999:3737 Test Server at School 2

This file is located in the C:\IGPRO directory on the client computer. Each 
time a teacher adds server access on the Open Gradebook screen, the 
information is added to this file, where it is used for future logons to the 
InteGrade Pro Server software.

Imported User Listing

When the system administrator imports users, the system attempts to 
send an e-mail to the administrator listing all of the imported users' User 
IDs and passwords. Each import also generates a log file named 
ImportUsersLog.txt and places the file in the Gradebook Root Directory 
specified within the InteGrade Pro Control Panel.

Event Log Files

The InteGrade Pro software now includes an InteGrade Pro Server 
Control Panel event log file that tracks user activity on the InteGrade Pro 
Server software. The most recent login information is also available on the 
Users tab of Control Panel.

This file is overwritten each time the system is unable to send the 
administrator e-mail.

http://k12.ncs.com/
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The log files are created each week and are named for the week they 
cover. For example, a file named:

2001-01-14to2001-01-20

covers the 7 days from January 14, 2001 through January 20, 2001.

The files are located in c:\"gradebook root directory"\_LOG. The following 
text provides an example of the type of information tracked in these new 
log files.

1/16/2001 10:18:27 AM Control Panel Control Panel opened 0.0.0.0

1/16/2001 10:20:06 AM Control Panel Control Panel closed 0.0.0.0

1/16/2001 12:55:47 PM Control Panel Control Panel opened 0.0.0.0

1/16/2001 12:58:04 PM Control Panel User lhunter added 0.0.0.0

1/16/2001 12:58:26 PM Control Panel User jsmith added 0.0.0.0

1/18/2001 9:58:44 AM Control Panel User lhunter added 0.0.0.0

1/18/2001 10:02:05 AM Control Panel Users Imported 0.0.0.0

Error Log Files

The software prompts the user after import or export if errors occurred. 
You can open error log files using a text editor (Notepad or SimpleText). 
This list shows the names of these files and when and where they are 
created.

ERRORLOG.ICL The InteGrade Pro software creates this file 
when importing a CLxxxxxx.GRD file. It is 
created in the same location as the 
CLxxxxxx.GRD file being imported.

ERRORLOG.IMK The InteGrade Pro software creates this file 
when exporting an MKxxxxxx.GRD file. It is 
created in the same location as the 
MKxxxxxx.GRD file being exported.

ERRORLOG.ACL The administration system creates this file when 
exporting a CLxxxxxx.GRD file. It is created in 
the same location as the CLxxxxxx.GRD file 
being exported.

ERRORLOG.AMK The administration system creates this file when 
importing an MKxxxxxx.GRD file. It is created in 
the same location as the MKxxxxxx.GRD file 
being imported.

http://k12.ncs.com/
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ERRINDEX.LOG The SASIxp software creates this file when 
importing an MK file or when exporting a CL file 
and errors are found for more than one teacher. 
This file lists the teachers with errors and lists the 
teacher folders containing teacher error log files. 
You can find this file in the School folder 
containing the Teacher folders.

TSS/TESS (7.1 and lower) software and OSIRIS software (before 
version 5) imports and exports do not generate error logs. TSS/TESS 
8.0 and Osiris 5 do generate error logs.

http://k12.ncs.com/
http://k12.ncs.com/


Copyright © 1998–2004 Pearson Digital Learning Where to Find More Information  21

About the InteGrade Pro Software

Where to Find More Information
If you need more information about the InteGrade Pro software, refer to 
the online help system or the InteGrade Pro User's Guide. You can 
download the User’s Guide from the Pearson Digital Learning Customer 
Link Web site. If you need additional assistance, contact Technical 
Support.

Technical Support Services
Pearson Digital Learning offers the following services to users with active 
maintenance agreements:

World Wide Web: Users with active maintenance agreements can get 
technical support from the Pearson Digital Learning Web site. Fill out 
the form on Customer Link (customerlink.pearsondigital.com) and a 
support person will send an e-mail response to you. You must be using 
a browser that displays forms to use this service.
Training: For information about the training services available from 
Pearson Digital Learning, or to schedule training, call (800) 736-4357.
Customer Service: For information about other products available 
Pearson Digital Learning call (800) 736-4357.

When Requesting Technical Support

Be sure you include the following information when requesting technical 
support:

Your site number.
The version of the InteGrade Pro software you are using and the 
platform on which you are running it. For example, InteGrade Pro 9.1 
software for Windows or InteGrade Pro 9.1 software for Macintosh.
Your computer make and model. For example, Dell® Dimension XPS 
166 or Apple Power Macintosh® 6100/60.
The computer operating system and version number. For example, 
Windows 2000 or Mac OS® X 10.2.8.
If InteGrade Pro is running on a local area network, the network 
operating system and version number.

http://www.pearsonncs.com
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Receiving Support from Other Vendors

If you purchased the InteGrade Pro software from a company other than 
Pearson Digital Learning, you should contact that company for technical 
support. You should have received information on technical support 
services available from that vendor at the time of purchase as well as upon 
receipt of the product.

http://k12.ncs.com/
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The InteGrade Pro software and InteGrade Pro Server software are 
available for download on the Customer Link Web site. The InteGrade Pro 
Web software installs when the InteGrade Pro Server software is installed.

The following sections contain the installation and configuration 
procedures for the software.

http://k12.ncs.com/
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Introduction
There are a number of ways to deploy the InteGrade Pro software. You 
can install the InteGrade Pro software on a stand-alone computer or on a 
client computer that connects to the InteGrade Pro Server software. You 
can also install the InteGrade Pro software on a network server and share 
it over a network using the network operating system's file sharing 
capabilities instead of using InteGrade Pro Server.

The InteGrade Pro 9.1 software can be installed regardless of whether you 
have a previous version of InteGrade Pro installed on your system.

If your school has a Windows-based network, Pearson Digital Learning 
recommends that you install the InteGrade Pro Server software and take 
advantage of the file serving capabilities of this new component. After the 
InteGrade Pro Server software is installed, you can either install the 
InteGrade Pro software on remote computers and configure them to 
connect to the InteGrade Pro Server software or you can simply have the 
remote computers connect to the InteGrade Pro Server software using the 
InteGrade Pro Web software.

Authorization Settings
Regardless of the deployment option selected, you must have the 
authorization information available to complete installation.

Authorization information includes the Licensee Name, the Site Number, 
and the Authorization Key. This information is normally provided to your 
site in an authorization letter from Pearson Digital Learning. If you cannot 
find this information, contact your InteGrade Pro support center.

General Installation Information

InteGrade Pro Software

The InteGrade Pro software can be used as a stand-alone product or as a 
client connected to the InteGrade Pro Server software. The functionality 
that allows the InteGrade Pro software to connect to the InteGrade Pro 
Server software can be toggled on and off with a setting in the Preferences 
menu of the InteGrade Pro software.

http://k12.ncs.com/
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InteGrade Pro Server Software

The InteGrade Pro Server software can be installed only on a Windows-
based network server. When you install the InteGrade Pro Server 
software, functionality for the Web server is also installed. Remote 
computers can connect to InteGrade Pro Server using InteGrade Pro or 
InteGrade Pro Web.

InteGrade Pro Web Software

The InteGrade Pro Web software has no additional installation 
requirements for the server computer. After the InteGrade Pro Server 
software is installed and configured, a remote computer with Internet 
connectivity can connect using the Web server's URL and a user ID and 
password assigned by the system administrator.

http://k12.ncs.com/
http://k12.ncs.com/


Installing the InteGrade Pro Software

26  Installing the InteGrade Pro Server Software Copyright © 1998–2004 Pearson Digital Learning

Installing the InteGrade Pro Server Software
To use the file-serving functionality of the InteGrade Pro Server software, 
follow the procedure below. If you want to use InteGrade Pro deployed 
over a network using the network operating system's file-sharing 
capabilities, see “Installing the InteGrade Pro Software on a Network 
Server” on page 33.

WARNING: Running in Demo Mode and Gradebook Access

If you run the InteGrade Pro Server software in DEMO mode, users will not 
have full access to gradebooks. They will have read-only access. For 
users to have full read-write access to gradebooks, you must install the 
InteGrade Pro Server software in fully-authorized mode.

If you are running the InteGrade Pro Server software in DEMO mode, you 
can switch to fully-authorized mode by opening the InteGrade Pro Server 
Control Panel. When prompted, you must provide the authorization 
information. This gives users full read-write access to their gradebooks.

Downloading and Installing the InteGrade Pro Server Software

You must have WinZip or a similar archive program to extract the 
installation files after downloading them.

To download and install the software:

1. On the network server, sign in to the Customer Link Web site at 
customerlink.pearsondigital.com.

2. Go to the InteGrade Pro Software Downloads Web page. (On the 
Customer Link Welcome page, select InteGrade Pro in the Product 
Support Center list, and then click the IGPro 9.1 link under 
Downloads.)

3. Click the IGPro_9.1_WIN.zip link and save the file to the root directory 
on your hard disk, usually C:\.

4. Unzip the IGPro_9.1_WIN.zip file to the root directory on your hard 
disk.

5. In the unzipped folder, open the \ADMIN\SERVER\ folder.

If you are installing this product on a system already running InteGrade 
Pro Server, the old version must be removed before running the 
installation program. Please see Uninstalling A Prior InteGrade Pro 9.0 
Install.rtf in this folder for details.

http://customerlink.pearsondigital.com/Download/IGPDLindex.asp
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6. Double-click Setup.exe and follow the instructions in the Installation 
wizard.

7. After the InteGrade Pro Server software is installed, reboot your PC. 
You must then complete the first-time Authorization Settings for the 
InteGrade Pro Server Control Panel as described in the next section.

First-Time Authorization Settings for InteGrade Pro Server Control Panel

These settings apply to the InteGrade Pro Server 9.1 software.

1. Be sure you have the InteGrade Pro Server Site and License numbers 
as well as the Authorization key. If you do not have this information, 
contact your InteGrade Pro representative.

2. After restarting your computer, open the Windows Control Panel.

3. Open the InteGrade Pro Server Control Panel. The Authorize 
InteGrade Pro Server Welcome screen is displayed.

4. Click Next to go to the Authorization screen.

5. Enter the Licensee Name, Site Number, and Authorization Key.

6. Click Next and Done. The InteGrade Pro Server Information screen is 
displayed. You must complete this information before using the 
InteGrade Pro Server Control Panel.

7. Enter an Administrator password and then re-enter the same password 
in the Confirm field. Be sure it is not easy to guess but that you will 
remember it. If you forget the password, you must re-install the 
InteGrade Pro Server Control Panel.

8. In the Server Options section, enter the maximum concurrent users 
you will allow to access the server. If this number is too high, you may 
see degradation in server performance. If it is too low, users will 
receive warning messages stating that no more connections are 
allowed. Adjust this number as required.

http://k12.ncs.com/
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9. Configure a default gradebook root path. This is where the teacher 
directories with gradebooks are stored.

10. Enter the maximum number of backups to keep. 

11. Click Configure InteGrade Pro Server. 

12. On the Configure InteGrade Pro Server screen, select the Provide 
services to InteGrade Pro clients checkbox.

13. Enter a port number and address for connecting InteGrade Pro clients 
to the InteGrade Pro Server software. The port number for InteGrade 
Pro clients and the port number for clients accessing the server with 
the InteGrade Pro Web cannot be the same.

14. Click Configure Web Server.

15. On Configure Web Server screen, select the Provide Web services to 
clients on port checkbox.

16. Enter the port number and address that InteGrade Pro clients will use 
to connect to the InteGrade Pro Server via the Web. The port number 
for InteGrade Pro clients and the port number for clients accessing the 
server with the InteGrade Pro Web must not be the same.

17. Set the session duration (time out). This is the maximum length of time 
(in minutes) that the InteGrade Pro Server waits between user 
requests before automatically ending the user’s session.

18. If you want you can enable SSL on this screen. See Enabling SSL on 
the Web Server on page 74.

19. In the e-mail Options section, enter the mail server address.

You must ensure that the gradebook directory is located on the 
server where the InteGrade Pro Server software is installed. Do not 
place the gradebook directory on another computer!

The default setting for the gradebook root path is \IGPDATA. 
Pearson Digital Learning recommends that you use it as it has the 
correct subdirectory structure for importing and creating gradebooks. 
If your school does not use an administration system, this does not 
apply.

Use caution when assigning port numbers. They must not conflict 
with another port currently in use.

Use caution when assigning port numbers. They must not conflict 
with another port currently in use.

http://k12.ncs.com/
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20. Enter the administrator e-mail login ID.

21. Enter a default e-mail address for the administrator.

22. Click OK to save the administrator information. You will see a warning 
message that says that InteGrade Pro Server Control Panel needs to 
be restarted before these settings take effect.

23. Click OK to close the Control Panel.

24. Restart the InteGrade Pro Server service. 

25. Open the InteGrade Pro Server Control Panel. Enter your 
administrator password. The InteGrade Pro Server Control Panel 
opens to the Users tab.

26. You can now configure the additional settings in the InteGrade Pro 
Server Control Panel. See Completing InteGrade Pro Server 
Configuration on page 72.

Windows File Sharing

Remove any Windows sharing from the folders that contain teacher 
gradebooks. File sharing for these folders is managed by InteGrade Pro 
Server and must not be interfered with by Windows file management 
services.

http://k12.ncs.com/
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Installing the InteGrade Pro Software
The following procedures show how to install the InteGrade Pro software 
for stand-alone operation and for computers that connect to the InteGrade 
Pro Server software. 

Downloading and Installing to a Windows PC

You must have WinZip or a similar archive program to extract the 
installation files after downloading them.

To download and install the InteGrade Pro software:

1. Sign in to the Customer Link Web site at 
customerlink.pearsondigital.com.

2. Go to the InteGrade Pro Software Downloads Web page. (On the 
Customer Link Welcome page, select InteGrade Pro in the Product 
Support Center list, and then click the IGPro 9.1 link under 
Downloads.)

3. Click the IGPro_9.1_WIN.zip link and save the file to the root directory 
on your hard disk, usually C:\.

4. Unzip the IGPro_9.1_WIN.zip file to the root directory on your hard 
disk.

5. In the unzipped folder, open the \IGPro folder.

6. Double-click Setup.exe and follow the instructions in the Installation 
wizard.

7. When prompted, type your Licensee Name, Site Number, and 
Authorization Key, and then click Install. If you cannot find the 
authorization letter with this information, contact technical support or 
your InteGrade Pro representative. 

8. On the Finished screen, click Next to view the Release Notes. Pearson 
Digital Learning recommends that you read the information in this file 
carefully as it contains important last-minute installation and 
configuration information.

9. On the Install Complete screen, click Done to quit the installer. A 
shortcut to InteGrade Pro is placed on your desktop.

http://customerlink.pearsondigital.com/Download/IGPDLindex.asp
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Downloading and Installing to a Macintosh Computer

To download and install the InteGrade Pro software:

1. Sign in to the Customer Link Web site at 
customerlink.pearsondigital.com.

2. Go to the InteGrade Pro Software Downloads Web page. (On the 
Customer Link Welcome page, select InteGrade Pro in the Product 
Support Center list, and then click the IGPro 9.1 link under 
Downloads.)

3. Click the IGPro_9.1_Mac.sit.hqx link. The file saves to your desktop.

4. Double-click the IGPro_9.1_Mac.sit.hqx file to unstuff it.

5. In the unstuffed folder, open the \IGPro folder.

6. Double-click Install InteGrade Pro and follow the instructions in the 
Installation wizard.

7. When prompted, type your Licensee Name, Site Number, and 
Authorization Key, and then click Install. If you cannot find the 
authorization letter with this information, contact technical support or 
your InteGrade Pro representative. 

8. On the Finished screen, click Next to view the Release Notes. Pearson 
Digital Learning recommends that you read the information in this file 
carefully as it contains important last-minute installation and 
configuration information.

9. On the Install Complete screen, click Done to quit the installer. 

http://customerlink.pearsondigital.com/Download/IGPDLindex.asp
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Using the InteGrade Pro Web Software

The Server Side
To use the InteGrade Pro Web software, you must install the InteGrade 
Pro Server component as described above. The InteGrade Pro Web 
software installs when the InteGrade Pro Server software is installed.

You must then configure the InteGrade Pro Server software as outlined in 
Chapter 3. The InteGrade Pro Server component includes all of the 
networking and Web-server functionality required for using InteGrade Pro 
Web.

The Client Computer Side

A remote computer that uses the InteGrade Pro Web software to access 
gradebooks on the school's InteGrade Pro Server requires the following:

It must have an Internet browser that meets the minimum system 
requirements (see Chapter 1).
It must have a connection to the Internet (dial-up, cable, etc.)
The Internet browser should be set to JavaScript enabled 
(performance is optimal when JavaScript is enabled).
The browser must be set to accept cookies.

Once these conditions are met, users can begin using InteGrade Pro Web 
provided that gradebooks have already been created on the server and 
InteGrade Pro Server has been configured. Information on logging in to 
InteGrade Pro Web can be found in the InteGrade Pro Web User's Guide.
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Installing the InteGrade Pro Software on a Network 
Server

This procedure is for installing the InteGrade Pro software on a network 
server and sharing the InteGrade Pro software over the network to client 
computers on the school LAN. This installation method assumes that 
InteGrade Pro program files will be shared over the network using the 
network operating system's file-sharing capabilities.

This procedure does not use the new InteGrade Pro Server file-serving 
functionality. This procedure is for users who wish to upgrade to the new 
version of InteGrade Pro to take advantage of the many defect fixes but 
who do not wish to install the new file serving functionality.

Downloading and Installing on the Server

Download and install the software on the server as described in “Installing 
the InteGrade Pro Software” on page 30.

Setting up File Sharing

Be sure to share the teachers' folders where the gradebook files are 
stored. Refer to the file sharing sections of your network operating 
system's documentation for guidelines on how to do this.
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Other Installation Options

Installing Client Computers over the Network
Computers that are connected to the school LAN can be installed over the 
network. You set up an installation folder on the network server and then 
run the installation program from each client computer.

To set up an installation folder on the network server:

1. On the network server, create a separate installation folder. The folder 
can have any name.

2. Copy the contents of InteGrade Pro installation folder created during 
the download from the Internet.

3. On each client computer, double-click the appropriate Install icon from 
the installation folder on the network server. Follow the instructions on 
your screen.
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Starting the InteGrade Pro Server Software
Once you have completed installation of the InteGrade Pro Server 
software, there is no need to start the Server service. During installation 
you are asked to reboot the computer and the Server is automatically 
started. This section is provided for information purposes in the event that 
the Server service is shut down.

For the InteGrade Pro Server software to be accessible to remote client 
computers, you must meet these conditions:

In the Windows Control Panel | Administrative Tools folder | Services, 
the InteGrade Pro Server service must always be running for 
computers to connect. You can start the server service manually but it 
is also started automatically when the InteGrade Pro Server software 
is first installed and each time the server PC is rebooted.
The InteGrade Pro Server Control Panel must be completely 
configured with Options and User information.

If the server has been shut down, reboot the server and InteGrade Pro 
Server will start. If you need to start InteGrade Pro Server manually, you 
can start the service by going to Services in the Administrative Tools folder 
of the Windows Control Panel. Depending on the type of Windows server 
you are using, the services may be configured in a different location. Refer 
to your operating system documentation for instructions on starting and 
stopping services.

WARNING: Running in Demo Mode and Gradebook Access

If you run the InteGrade Pro Server software in DEMO mode, users will not 
have full access to gradebooks. They will have read-only access. In order 
for users to have full read-write access to gradebooks, you must install the 
InteGrade Pro Server software in fully authorized mode.

If you are running the InteGrade Pro Server software in DEMO mode, you 
can switch to fully-authorized mode by opening the InteGrade Pro Server 
Control Panel. When prompted, you must enter the authorization 
information. This will allow users full read-write access to their 
gradebooks.
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Starting the InteGrade Pro Software

Starting the InteGrade Pro Software for the First Time
The first time you run the InteGrade Pro software you are given the option 
of indicating whether you will be using it stand-alone (only storing 
gradebooks locally) or whether you will connect to the InteGrade Pro 
Server software (storing gradebooks remotely).

Starting Without the InteGrade Pro Server Software

Use this procedure to open InteGrade Pro the first time only if you will not 
be connecting to InteGrade Pro Server. This procedure will configure your 
system to run as a stand-alone or to run on the school's LAN without using 
InteGrade Pro Server. Gradebooks will only be stored locally.

1. Double-click the InteGrade Pro icon. You will see the following 
message:

2. Select No. This indicates that you will be installing without connectivity 
to the InteGrade Pro Server software.

3. Click Continue. The InteGrade Pro banner screen is displayed.

4. On the InteGrade Pro banner screen, select Open a gradebook on 
your computer and click OK.

5. When the Open screen appears, click Cancel and close InteGrade 
Pro. This completes the requirements of the first-time startup.
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Starting With the InteGrade Pro Server Software

Use this procedure to open the InteGrade Pro software the first time only if 
you will be connecting to the InteGrade Pro Server software. This 
procedure will configure your system to store gradebooks remotely on the 
school's server.

1. On the computer desktop, double-click the InteGrade Pro icon. You will 
see the following message:

2. Select Yes. This indicates that you will be installing on a computer that 
will connect to InteGrade Pro Server at school.

3. Click Continue. The InteGrade Pro banner screen displays.

4. Select the Open a gradebook on a server option and click OK. The 
Open Gradebook screen appears.

5. To see a description of the various parts of the Open Gradebook 
screen, click the Help button. At this point teachers must add server 
connectivity so that the computer can connect to the InteGrade Pro 
Server software.

6. See the online Help and the InteGrade Pro User's Guide for 
instructions on connecting to the remote server and opening and 
closing gradebooks.

Starting the InteGrade Pro Software (After the First Time)

If you are starting InteGrade Pro for the first time, see Starting the 
InteGrade Pro Software for the First Time procedure above.
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Starting Without the InteGrade Pro Server Software

For all subsequent times that you open the InteGrade Pro software, do the 
following:

1. Double-click the InteGrade Pro icon.

2. On the InteGrade Pro banner screen, select Open a gradebook on 
your computer and click OK.

3. On the Open screen, select a gradebook to open and click Open.

Starting With the InteGrade Pro Server Software

For all subsequent times that you open the InteGrade Pro software, do the 
following. 

1. Double-click the InteGrade Pro icon. The InteGrade Pro banner screen 
displays.

2. On the InteGrade Pro banner screen select Open a Gradebook on a 
server and click OK. The Open Gradebook screen displays.

3. See the online Help or the InteGrade Pro User's Guide for instructions 
on connecting to the server and opening and closing gradebooks.

Starting the InteGrade Pro Web Software
For instructions on starting and using the InteGrade Pro Web software, 
see the InteGrade Pro Web User's Guide.

Each time you open a gradebook that was created using a previous 
version of InteGrade Pro, you will see a message asking if you want to 
proceed and convert the file. Once a file has been opened in the later 
version, you cannot not open it using earlier versions of InteGrade Pro.
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This chapter describes how InteGrade Pro may be deployed so teachers 
can securely use it remotely while still keeping data centralized on a 
school or district server. In particular, it provides technical details on the 
configuration and operation of the InteGrade Pro software and InteGrade 
Pro Server software service for gradebook access from outside of a school 
district’s internal network.

http://k12.ncs.com/


Remote Access

40  Introduction Copyright © 1998–2004 Pearson Digital Learning

Introduction
There are two ways to provide teachers external access over the Internet 
to data on an InteGrade Pro server. The first is through InteGrade Pro 
Web, and the other is by choosing to implement InteGrade Pro server with 
a remote deployment.

This chapter assumes you have installed the InteGrade Pro Server 
software and configured it (see also Installing the InteGrade Pro Software, 
and The InteGrade Pro Server Control Panel). Remote Deployment also 
assumes you can implement the required firewall redirection rules based 
on the specific configuration procedures of your school’s network firewall.

InteGrade Pro Web

Operation

The Web Users Guide describes how to use InteGrade Pro Web. See 
Getting Started, chapter 2 of the Web User’s Guide, for more information.

Configuration

Configuring InteGrade Pro Web is completely described in The InteGrade 
Pro Server Control Panel. 

InteGrade Pro Remote

Operation

The InteGrade Pro User’s Guide describes how teachers use gradebooks. 
See Working with Gradebooks in the InteGrade Pro User’s Guide.

Configuration

The InteGrade Pro remote deployment is described in the following 
section.
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InteGrade Pro Remote Deployment Architectural Overview

With the use of a specially configured installation of the InteGrade Pro 
software installed at an end-user’s home, it is possible to interact with the 
gradebooks stored on an InteGrade Pro Server that is located behind a 
school district’s external firewall.

Other than the configuration limits of the firewall, there are no limitations 
on the location and quantity of InteGrade Pro servers that can be 
accessed, provided that an open TCP/IP network path exists between the 
InteGrade Pro server and the external firewall.

This operation is identical to InteGrade Pro Server operations that occur 
within the internal network with the additional requirement that the 
communication between the end-user and the InteGrade Pro Server must 
pass through an appropriately created firewall redirection rule that will 
allow the data to flow properly between the end-user and the InteGrade 
Pro Server.

All communication between the end-user and the InteGrade Pro Server is 
encrypted by the InteGrade Pro Server. 
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InteGrade Pro Remote Configuration

A remote deployment can be thought of having four phases of 
configuration:

Phase 1 - InteGrade Pro Server and Firewall Configuration Planning

Phase 2 - InteGrade Pro Server TCP/IP Parameter Configuration

Phase 3 - Firewall Redirection Rule Configuration

Phase 4 - InteGrade Pro software Configuration and Distribution

Phase 1 - Configuration Planning

In phase 1, design an environment that provides a unique path of 
communication from the external side of the firewall to the InteGrade Pro 
server that is accessed from an external system

Each InteGrade Pro Server is accessed through a unique combination of 
TCP/IP address and TCP Port assignment. Likewise, a unique 
combination of TCP/IP address-TCP Port pairs must be available on the 
external port of the firewall. This approach allows for the definition of TCP/

Remote Teacher

IGPro Sv r

IGPro Remote Configuration
Phases

IGPro Sv r

IGPro Sv r

IGPro Sv r

Firewall
Redirection

Rules

Phase 4
IGPro Application Configuration

(remote access version) Phase 1
IGPro Server/Firewall

Configuration Planning

Phase 2
IGPro Server

TCP/IP Parameter
Configuration

Phase 3
Firewall

Redirection Rule
Configuration
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IP Address/TCP Port pair assignments on both the firewall and IGPro 
Servers so that unique firewall redirection rules can be created for each 
IGPro Server that is to be accessed from an external location.

The number of internal InteGrade Pro Servers that you can make 
accessible to external end-users is limited to the flexibility of configuration 
provided by the firewall and, potentially, the number of public TCP/IP 
addresses assigned to the firewall.

Remote Teacher
w/

Tradit ional IGPro
Client

The “remote” c lient w ould have special
conf igurations for IGPro Servers pointing
to the associated e xternal address/port
assignments that have redirection rules
assigned to them

146 10.1.1.1 146
From Port To Address To Port

Firewall
208.92.68.42

Port Redirection Rules

Firew all rule processed and redirected

IGPro Serv er 1

10.1.1.1
146 (def ault)

F irewall

IGPro Remote Operational Overview
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The choice of which TCP Ports to use in this configuration must be 
defined by the local network administrator and meet the 
requirements of the customer’s network security policies.

Model 1 - Common Public Firewall Address / Unique TCP Port

In this model a single public TCP/IP firewall address will be redirected to 
multiple IGPro Servers behind the firewall. A unique TCP port on the 
public TCP/IP address must be made available for each IGPro Server that 
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is to be accessed from an external location.In that one public address will 
be used in creating the redirection rules, it will be necessary to assign a 
unique network-wide TCP port to each IGPro Server. 

Remote Teacher
w/

Traditional IGPro
Client

The “remote” client would connect to the
desired “IGPro Server”, which is actually a
predef ined f irewall port that has a
redirection rule applied to it.

IGPro Server 2

10.1.1.2
147

IGPro Server 1

10.1.1.1
146 (default)

IGPro Remote Configuration Matrix
(Common Public TCP/IP Address - Unique TCP Ports)

Firewall
Redirection

10.1.1.1
10.1.1.2

146
147

IGPro
Server Address

IGPro
Server Port

209.52.17.26
209.52.17.26

146
147

Public
Firewall Address Firewall Port

*** NOTE ***

The TCP/IP addresses and TCP ports used
in this drawing are for explanatory
purposes only.

The actual addresses and ports assigned
will be dependent on the operational
network infrastructure that is in place.

It is possible to use a DNS name as part of
the configuration of the remote IGPro
client provided the defined name exists in
a publicly accessible DNS namespace and
references the public side of the firewall
device.
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Model 2 – Unique Public Firewall Address/Common TCP Port

In this model multiple public TCP/IP firewall addresses are redirected to 
multiple IGPro Servers behind the firewall. A unique public TCP/IP 
address must be made available for each IGPro Server that is accessed 
from an external location.

In that multiple public addresses will be used in creating the redirection 
rules, it is possible to assign a common TCP port to all IGPro Servers. 

Remote Teacher
w/

Traditional IGPro
Client

The “remote” client would connect to the
desired “IGPro Server”, which is actually a
predef ined f irewall port that has a
redirection rule applied to it.

IGPro Server 2

10.1.1.2
146 (default)

IGPro Server 1

10.1.1.1
146 (default)

IGPro Remote Configuration Matrix
(Unique Public TCP/IP Address - Common TCP Ports)

Firewall
Redirection

10.1.1.1
10.1.1.2

146
146

IGPro
Server Address

IGPro
Server Port

209.52.17.26
209.52.17.27

146
146

Public
Firewall Address Firewall Port

*** NOTE ***

The TCP/IP addresses and TCP ports used
in this drawing are for explanatory
purposes only.

The actual addresses and ports assigned
will be dependent on the operational
network infrastructure that is in place.

It is possible to use a DNS name as part of
the configuration of the remote IGPro
client provided the defined name exists in
a publicly accessible DNS namespace and
references the public side of the firewall
device.
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IGPro Remote Redirection Rule Configuration Matrix

It is critical to design this martix in a way that provides for the creation of a 
unique firewall redirection rule for each IGPro Server that is accessed from 
an external location.

An example matrix appears below. 

Redirection

Name Description
Internal TCP/IP 

Address
TCP 
Port

Public TCP/IP 
Address

TCP 
Port

IGSVR1 HS Svr 10.1.1.1 146 <-> 209.52.17.26 146
IGSVR2 MS Svr 10.1.1.2 147 <-> 209.52.17.26 147

<->
<->
<->
<->
<->
<->
<->
<->
<->
<->
<->
<->
<->
<->
<->
<->
<->
<->

IGPro Server Configuration Firewall Configuration
IGPro Remote Redirection Matrix

http://k12.ncs.com/


Remote Access

48  Introduction Copyright © 1998–2004 Pearson Digital Learning

Phase 2 – IGPro Server TCP/IP Parameter Configuration

Prior to attempting this phase of the configuration, you must define a 
firewall redirection matrix as explained in the previous section.

To configure the TCP/IP parameters:

1. If InteGrade Pro Server software is not yet installed, install the service 
per the instructions provided in the InteGrade Pro Administrator’s 
Guide.

2. If the InteGrade Pro Server service is running, stop the service.

3. Open the InteGrade Pro Server applet from the Control Panel. Enter 
the InteGrade Pro Server Administration password and click OK.

4. The InteGrade Pro Server Control dialog box displays. Select the 
Options tab.

5. Click Configure InteGrade Pro Server.

6. Select the Provide services to InteGrade Pro clients checkbox.

7. Enter the internal information for the InteGrade Pro Server as defined 
in the Redirection Matrix. The address/port parameters must reference 
the internal network configuration of the InteGrade Pro Server system. 
While a TCP/IP address is preferred, the address can be an internally 
resolved DNS name.
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8. Click OK.

9. Click OK on the InteGrade Pro Server Control dialog to close the 
applet.

10. Restart the InteGrade Pro Server service.

Phase 3 – Firewall Redirection Rule Configuration

Due to the broad range of firewall products available and their associated 
configuration capabilities, it is beyond the scope of this document to be 
able to provide specific firewall configuration rule procedures for any 
particular vendor or product.
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Prior to attempting this phase of the configuration, you must define a 
firewall redirection matrix as previously noted in the Phase I section.

The key to the successful operation of this type of implementation is to 
ensure the ability of the TCP/IP communications stream on the desired 
TCP port to flow from the end-user’s workstation through any firewalls that 
may exist in the communications path (e.g. home, ISP, and district/school 
firewalls).

To configure the firewall redirection rules:

1. Configure the firewall redirection rules of the firewall to provide for the 
redirection of TCP/IP communications from the external port of the 
firewall to the InteGrade Pro Server.

2. Ensure the end-user understands any configuration that may be 
required within their home network to permit the flow of 
communications on the desired TCP/IP port.

Phase 4 – IGPro Software Configuration and Distribution

In addition to providing the end-user with a specially configured version of 
the InteGrade Pro software for external use, it is important to make the 
end-user aware of any configurations that may be required within their 
home network to permit the flow of communications on the desired TCP/IP 
port.
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If both Windows and Macintosh versions of the InteGrade Pro software are 
used at external locations, perform separate installations for each version 
of the application.

While these instructions address the procedure for creating a Windows 
installation, similar techniques can be used to create a Macintosh version 
of the installation.

To confgure the InteGrade Pro software:

1. Locate an existing installation of the InteGrade Pro software.

2. Make a copy of this installation to a new folder.

3. Rename the folder.

4. Open the folder and delete the servers.cfg file if it exists.

5. Run the InteGrade Pro software from this folder. A prompt may appear 
asking for the type of storage desired for this installation. Is so, select 
Yes, I’d like to store my gradebooks on my school’s InteGrade Pro 
Server. Click Continue.

6. The InteGrade Pro software interface displays. Click Cancel.

7. On the Edit menu, click Preferences.

8. Configure the Preferences dialog as depicted below and click OK.

9. On the File menu, click Open Gradebook.

10. On the Warning dialog, click OK .
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11. In the Add Server dialog box, type the public information of the firewall 
redirection rule for the IGPro Server.

Server Name — The user interface display name associated with the 
IGPro Server to be accessed.

Address — The TCP/IP address and TCP Port of the public firewall 
redirection rule that will permit the flow of communications from the 
external location to the internal IGPro Server.

The TCP/IP address and TCP Port should be separated with a colon 
as shown in the illustration above.

A DNS name can be used as part of the address definition but it must 
be a DNS name that can be resolved publicly and references the 
appropriate public address of the firewall.

12. Click Add. The Open dialog box displays.

13. On the Servers menu, click Add Servers to create additional server 
definitions as explained in the previous steps of this procedure.

14. When you have added all the server definitions, click Cancel.

15. Exit the InteGrade Pro software.
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Packing and Distribution

Many different approaches can be utilized to provide for distribution of the 
externally configured installation of the InteGrade Pro software. 

The procedures outlined in this section of the document have been 
provided as a simple method of creating a software distribution. This 
procedure assumes the availability of a compression utility and the 
knowledge of its use.

To create a software distribution

1. Locate the folder containing the externally configured installation of the 
InteGrade Pro software.

2. Archive the folder to a compressed file that includes the directory path 
information.
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3. Create a self-extracting archive from the compressed file.

4. Package and distribute the self-extracting archive in the manner most 
appropriate to the school district (e.g. FTP, HTTP, CD, etc.).
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Using Microsoft Certificate Services with 
InteGrade Pro Server Software

This chapter explains how to install the Microsoft Certificate Service as a 
standalone Root Certificate Authority on a Windows 2000 Server and 
issue a certificate to be used by an InteGrade Pro Server software service 
installed on the same machine. 
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Introduction
InteGrade Pro Server software includes the ability to use data encryption 
with the Web-based component using the standard Secure Sockets Layer 
(SSL) protocol. Enabling SSL requires a certificate for your InteGrade Pro 
Server. This certificate includes the public key used in the data encryption 
process. 

A certificate can be purchased each year from a third party Root 
Certificate Authority, such as VeriSign®. But, to help lower the cost of 
ownership for their customers, Microsoft has included the ability to self-
issue certificates in their Windows 2000 server products. This optional 
software is the Microsoft Certificate Service and is included at no extra 
cost. 

To install this service and issue a certificate for the use of InteGrade Pro 
Web, you will need to perform the procedures in this chapter. These 
procedures explain how to install the Microsoft Certificate Service as a 
standalone Root Certificate Authority on a Windows 2000 Server and 
issue a certificate to be used by the InteGrade Pro Server service installed 
on the same machine. You can then follow the instructions in the chapter 
The InteGrade Pro Server Control Panel to complete your installation. 

Preconditions 

On the dedicated server you are using for InteGrade Pro Server and 
InteGrade Pro Web:

Ensure the partition Windows 2000 is installed in has been formatted 
as NTFS.
Ensure InteGrade Pro Server software is installed and configured as 
described in this Guide.

Installing Microsoft Certificate Services as a Standalone Root Certificate 
Authority 

Microsoft Internet Information Services is normally installed by default 
during an installation of Windows 2000 Server. If it was not installed, you 
will need to install it to be able to work with the Microsoft Certificate 
Services Web enrollment pages. The Microsoft Certificate Services option 
is not installed by default.
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To Install these additional windows Microsoft Certificate Services 
components:

1. In Control Panel, double-click Add/Remove Programs.

2. Click Add/Remove Windows components, then select the Certificate 
Services check box.

3. Select the Internet Information Services (ISS) check box if needed. A 
warning about not changing the server name appears.

4. Select Yes, and then click Next.

5. Select Standalone Root Certificate Authority, select Advanced 
Options, and click Next.

6. In the Public and Private Key Pair dialog box, click 1024 for the key 
length. Leave all other selections as default and click on Next.

7. Fill out the CA Identifying Information form with the appropriate entries 
for your site. You must spell out your State name. You will also need to 
determine how long you want this CA to be valid. The default is 2 
years. After that time you would need to renew the certificate for this 
CA. After you have filled out all the entries, click Next.

8. Accept the defaults for the Data Storage locations and click Next.

9. Click Finish after the componenet configuration is complete.
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10. Close the Add / Remove Programs screen. This completes the 
installation of your Root Certificate Authority. This is the authority that 
you will use to request and receive a server certificate from.

Install InteGrade Pro Server Software

If you have not already done so, follow the directions for Installing the 
InteGrade Pro Software on page 23. After you have the Server installed, 
you can configure the Control Panel Applet using the instructions for 
Completing InteGrade Pro Server Configuration on page 72.

Pearson Digital Learning strongly recommends that you use the SSL 
features of the InteGrade Pro Web Server. By doing so you ensure that the 
data transmitted across the Internet is protected by encryption. You can 
implement SSL on the InteGrade Pro Web Server by following the 
instructions for Enabling SSL on the Web Server on page 74.

Note: Use the IP address for your server in the Common name field when 
generating your request using openssl. This will ensure that your 
certificate matches the InteGrade Pro Web site on your server. If you do 
not use the IP address as the common name, the end users will receive an 
information alert that the name of the Web site does not match the name 
on the certificate.

Note: When using the openssl program to create your key and certificate 
request files, use the command as shown in the following graphic.

Requesting Certificates from Your Microsoft Certificate Services CA

To use the Microsoft Certificate Services to issue a server certificate, use 
this procedure instead of the instructions for Requesting Certificates from 
a Certificate Authority (CA) on page 76.

To submit a certificate request to your online CA:

1. In the Control Panel, double click Administration Tools.

2. Double click Internet Services Manager.
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3. Expand the icon for your server.

4. Expand the Default Web Site.

5. Right click the CertSrv folder and select Browse. You may have to 
configure Internet Explorer if this is the first time it has been 
opened.The Microsoft Certificate Services Wizard diplays. 

6. Click the Home Link in the upper right of the screen. This ensures that 
the certsrv portion of the URL is in lower case. If it is not in lower case, 
the certificate you issue may not be usable. 

7. Select Request a certificate, and then click Next.

8. In the Choose Request Type screen select Advanced Request, and 
then click Next.

9. In the Advanced Certificate Request screen, select the middle option 
(submit using base 64) and click Next.

10. Leave the Submit a Saved Request screen open. Run WordPad, and 
then open the file C:\cert\certreq.pem. 

11. Copy the entire text of the file by highlighting the text and then pressing 
Ctrl-C. Do not use the select all function to do this as it will include 
blank spaces that are not allowed by the Certificate Services.

12. Paste the text into the Saved Request block in the Submit a Saved 
Request window. Then click Submit and leave Internet Explorer open.
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13. Go to Start, Programs, Administrative Tools, Certification Authority. 
Expand your server and open the Pending Requests folder. Right click 
the request, select All Tasks, and Issue the certificate.

14. In the Certificate Services window that you left open, click the Home 
link. Select Check on a Pending Certificate and click Next.

15. Select the Saved-Request, and then click Next.

16. In the Certificate Issued screen, select Base64 encoded and click 
Download CA Certificate.

17. In the File Download screen, select Save This File to Disk and click 
OK.

18. In the Save As screen, navigate to the C:\cert folder and name the file 
to be saved cert.cer. click Save. Close the Certificate Sercives Window 
and go the next procedure.
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Exporting the Security Certificate

To export the security certificate.

1. In the C:\cert folder, right click the cert.cer file you just saved, and 
select open.

2. In the Certificate dialog box, click the Certification Path tab, and then 
click the topmost certificate.

3. Click View Certificate.

4. Click the Details tab and click Copy to File. The Certificate Export 
wizard displays.

5. Click Next.

6. In the Export File Format screen, select Base-64, and then click Next.

7. In the File to Export screen, browse to the cert folder and then name 
the file to be saved as CAcert.cer. 

8. Click save, and then click Next.

9. Click Finish in the Completing the Certificate Export window. In the 
Success message, click OK.
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Converting the File Format for the CA and Server Certificate files

To convert the file format of the CA and Server Cerificate files.

1. Run WordPad. 

2. Open the cert.cer file. 

3. Under the File menu, select Save. Save the file as “cert.pem”. (Include 
the quotation marks in the name to prevent WordPad from attaching 
the default file extension.) 

4. In the format information message, click Yes. This will save the file with 
no formatting.

5. Open CAcert.cer file using WordPad. 

6. Under the File menu, select Save. Save that file as “CAcert.pem”. 
(Again, remember to include the quotation marks.) 
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Configuring the InteGrade Pro Server Software

You should now have all three of the files that are needed to configure the 
InteGrade Pro Server software applet in the Control Panel. You will find 
the instructions for this step in the section entitled Enabling SSL on the 
Web Server on page 74. The Web server configuration form should look 
similar to the image below when complete. Be sure to use your IP address 
and key password in your form.
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Optional Steps for the End User to Perform

The first time the end user connects to the InteGrade Pro Web site, they 
will receive a Security Alert message similar to the one below. This is 
normal because the Root Authority used to issue the InteGrade Pro Web 
server certificate is not listed in the browser’s included list of known Root 
Authorities.

To keep this Security Alert from being displayed every time the user 
connects to the site, you will need to allow them to access the certificate 
services Web page that will allow them to load the Root Authority 
certificate into their browser. To access the Web page, have them go to 
your server’s IP address and access the certsrv/certcarc.asp page. They 
should then select Install this CA certification path.
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The user should check the information in the Root Certificate Store 
window. If the certificate is the correct one, they can then click Yes. The 
example below shows the kind of information the user can inspect to verify 
the Root Store.
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The user will receive a message that the CA certificate has been 
successfully installed. They can then close the message window. 

Disable the Internet Information Service

The InteGrade Pro Server does not use the Microsoft Internet Information 
Service. It is only needed when you need to work with the Microsoft 
Certificate Services Web pages to issue or renew your certificates, or for 
the end users to download the Root Certificate Authority certificate to their 
browser. 

To increase the security of your server you should disable the IIS service 
whenever it is not needed. 

1. Go to Start, Programs, Admin Tools, Services. 

2. Right click the IIS Admin Service and select properties. 

3. On the general tab select the Startup type to be Disabled. Click OK.

You can also disable Certificate Services when they are not needed. 
The service does not need to be running for the normal operation of 
the server.

4. Once you have disabled these services, restart your server.

Remember that you will need to re-enable these services whenever you 
need to issue or renew your certificates, or for the end users to download 
the Root Authority Certificate.
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Ongoing Server Maintenance

To keep your InteGrade Pro server as safe from attack as possible you 
must ensure that the latest Service Packs and HotFixes are installed. The 
latest Service Packs and HotFixes are available for download at 
Microsoft’s Web site. Use the following link to check on Service Packs:

http://www.microsoft.com/technet/treeview/default.asp?url=/technet/
downloads/default.asp

Use this link to check on the latest Security Bulletins and their associated 
HotFixes:

http://www.microsoft.com/technet/treeview/default.asp?url=/technet/
security/default.asp

These links may change. Search the Microsoft Web site if the links are no 
longer active.

http://www.microsoft.com/technet/treeview/default.asp?url=/technet/downloads/default.asp
http://www.microsoft.com/technet/treeview/default.asp?url=/technet/security/default.asp
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Before using the procedures in this chapter, you must ensure that you 
have properly installed the InteGrade Pro Server software. The previous 
chapters provide instructions for completing installation.
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Introduction
After you complete installation of the InteGrade Pro Server software and 
you configure the initial connection settings, you must configure user and 
other information. After you configure user information, remote client 
computers can access gradebooks managed by the InteGrade Pro Server 
software.

When Changing Control Panel Settings
Before you make changes to information on the Options tab of InteGrade 
Pro Server Control Panel, you must stop the InteGrade Pro Server service. 
See your operating system’s documentation for instructions on how to stop 
services.

The name of the service you need to stop is InteGrade Pro Server. When 
you reboot the system, the InteGrade Pro Server service is automatically 
re-started. However, if you stop it manually to make changes you must 
restart it manually as well.

Overview of Configuring InteGrade Pro Server Control Panel
Use the following checklist to ensure you complete all necessary 
configurations. Details for completing each of these procedures are in the 
sections that follow. You have the ability to enable or disable Secure 
Sockets Layer (SSL) protocol in the Options tab of the control panel.

1. Stop the InteGrade Pro Server service and open the InteGrade Pro 
Server Control Panel.

2. Read the About tab for version information.

3. Confirm that the information on the subscreens of Options tab is 
correct. This information was collected by the authorization wizard the 
first time you opened the InteGrade Pro Server Control Panel. Ensure 
that all fields under these subscreens are completed.

4. Complete the user password settings on the Common Settings 
subscreen of the Options tab. Special Note: If you wish to make a 
change to the Administrator password you do so from the Change 
Administrator Password subscreen of the Options tab.

If you do not complete the e-mail subscreen (launched by the 
Change e-mail Settings button) before you enter users, the users will 
not receive any account/logon information through e-mail and will 
not be able to log on to the system without your assistance.
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5. Add users on the Users tab. Here you can choose to import users if 
there is an administration system that has exported class roster files 
for import. If not, you must add users manually to the system.

6. On the Users tab, select a user and either double-click the user or click 
Properties... . In the dialog that comes up, complete the Access tab. 
Repeat this step for each user. This is how you give users access to 
gradebooks.

7. Create bulletins. For example, you can create bulletins that include 
Web site links or bulletins to provide users with information about the 
new system, current events and so on.
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Completing InteGrade Pro Server Configuration

Opening the InteGrade Pro Server Control Panel
1. Stop the InteGrade Pro Server service using the procedures provided 

in your operating system's documentation. The service you must stop 
is called InteGrade Pro Server.

2. Go to the Windows Control Panel and double-click the InteGrade Pro 
Server icon.

3. On the Control Panel Security Check screen, enter your administrator 
password. If you have forgotten your administrator password you must 
re-install the InteGrade Pro Server software and reset your password. 
This will not affect user information already entered.

When you open the Server Control Panel, the Users tab displays.

Reading the About Tab

Pearson Digital Learning recommends that you familiarize yourself with 
the information on the About tab. This tab provides version information that 
will be important if you require assistance from your support center.

Confirming Options Tab Information

When you run the installation and open InteGrade Pro Server Control 
Panel for the first time, the first-run authorization wizard collects 
connection information, which is displayed on the Options tab.

To make changes to the Options tab, you must stop the InteGrade Pro 
Server service. See your operating system documentation for further 
information on how to stop and start a service. After making changes to 
the Options tab, close the Server Control Panel and restart the Server 
service.
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To complete configuration, go to the Options tab.

1. Click Show Common Settings. Set the maximum number of concurrent 
users. If this number is too high, you may see server performance 
degrade. If it is too low, users get warning messages stating no more 
connections are allowed. Adjust this number as required. 

2. Be sure the gradebook root path is set to where you plan to store 
teacher folders and gradebooks. .

3. Set the maximum number of backups to keep. Click OK.

4. Click Show InteGrade Pro Server Settings. 

5. On the Show InteGrade Pro Server Settings screen, confirm that the 
Provide services to InteGrade Pro clients checkbox is selected and 
that the IP address and port numbers are correct. If the Provide 
services to InteGrade Pro clients checkbox is not selected, the 
InteGrade Pro server functionality is disabled. Click OK. 

6. Click Show Web Server Settings. 

7. On the Show Web Server Settings screen, confirm that the Provide 
services to Web Clients on port checkbox is selected and the IP 
address and port numbers are correct. 

8. Set the session duration (in minutes) using the Timeout spinbox. This 
is the maximum length of time that the InteGrade Pro Server will wait 
between user requests before automatically ending the user’s session.

9. Set the Maximum Sessions value. This is the maximum number of 
users that can concurrently connect to InteGrade Pro Web server.

10. You can enable SSL in this screen. See Enabling SSL on the Web 
Server on page 74. Click OK.

You must ensure that the gradebook directory is located on the 
server where the InteGrade Pro Server software is installed. Do not 
place the gradebook directory on another computer! 

A status ball located on the Show InteGrade Pro Server Settings 
icon quickly identifies that client access to services is set. If the 
status ball is green, it indicates that the InteGrade Pro Server is 
enabled to provide services. 

Use caution when assigning port numbers to be used by InteGrade 
Pro and InteGrade Pro Web clients.
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11. Click Change e-mail Settings. Ensure that all e-mail options are 
accurate. It is imperative that this information be correct so that 
teachers can receive e-mails that provide their user IDs and 
passwords, as you set them up.

Enabling SSL on the Web Server
In order to enab to enable the Secure Sockets Layer functionality on your 
Web server you must have the following files:

a Key file
a Certificate Signing Request (CSR)
a Server certificate
a CA certificate

You must generate the first two files. Once you have done that, you must 
request the last two files from a Certificate Authority. Complete the 
following procedures to create and obtain the files.

Generating a Key and a Certificate Signing Request (CSR)

You must have the following two files to complete this procedure:

openssl.exe
openssl.cnf

These files are used to generate the Key and CSR. They are available for 
download from the Internet.

1. Create a C:\cert folder.

2. Place the openssl.exe and openssl.cnf files in the C:\cert folder.

3. Start a DOS session, and navigate to the C:\cert folder by typing:

cd c:\cert

4. Type the following command and press Enter:

openssl req -new -keyout certKey.pem -out 
certReq.pem -days 365 -config openssl.cnf

5. You are prompted to complete the following information about the 
certificate’s ownership: 
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Enter PEM Pass phrase:

6. Enter the password for your certificate and press Enter. You can use 
any password. It should be easy enough to remember and difficult 
enough that it can’t be easily guessed. This is the password to your 
private key that will be used with your public key that is included in your 
certificate. These two keys are used in setting up the secure link 
between a user’s browser and the InteGrade Pro server. This 
password should be very strong, at least 11 characters, made up of 
alphanumeric and special characters.

Verifying password-Enter PEM pass phrase

7. Enter the password again to make sure it was entered correctly and 
press Enter.

Country Name:

8. Enter the two letter code for the country location and press Enter.

State or Province: 

9. Enter the full name of your state or province location and press Enter.

Locality Name: 

10. Enter the name of your city location and press Enter.

Organization Name:

11. Enter the name of the school the certificate is for and press Enter.

Organizational Unit Name:

12. Enter a specific department and press Enter.

Common Name:

13. Enter the name or IP Address of your server (for example, 
192.168.1.1). Do not add any header information to this. (Do not use 
the DNS name here, use the IP address only. If the DNS name is used 
the certificate will not match the site name and the user will get an alert 
message when they go to the site.)

E-mail Address:

14. Enter your e-mail address and press Enter.

A Challenge Password:

15. Enter a password of any character length and press Enter.

An optional company name:

16. Enter the name of the school the certificate is for and press Enter.
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17. Confirm that you have two .pem files in the c:\Cert\ folder: one named 
certKey.pem and another named certReq.pem.

18. The contents of the certReq.pem file should look similar to this when 
opened with WordPad or another text editor.

The certReq.pem file is your CSR. When you apply for a certificate from a 
trusted authority, you supply the CA with the contents of the certReq.pem 
file. The certKey.pem file is the key file that is used with the Server 
certificate.

Requesting Certificates from a Certificate Authority (CA)

Once you have generated a Key and a Certificate Signing Request (CSR), 
you select the Certificate Authority who will supply your Server certificates.

The process for requesting certificates varies for each Certificate Authority 
but generally conforms to the following procedures:

1. Supply the Certificate Signing Request (CSR). The Certificate 
Authority typically asks you for the contents of the certReq.pem file 
and not the file itself. 

2. Make sure when sending your Certificate Signing Request (CSR), that 
there is no text above the following line:

-----BEGIN CERTIFICATE REQUEST----- 

3. Make sure there is no text below the following line: 

-----END CERTIFICATE REQUEST----- 

If you are asked to specify the Web server that the certificate you are 
requesting will be used on, specify Apache/Stronghold.

-----BEGIN CERTIFICATE REQUEST----- 
MIICPjCCAacCAQAwgb0xCzAJBgNVBAYTAkNBMRkwFwYDVQQIExBCcml0aXNoIENv 
bHVtYmlhMRMwEQYDVQQHEwpBYmJvdHNmb3JkMR8wHQYDVQQKExZEaXNjb3Zlcnkg 
U29md+dhcmUgTHRkMRAwDgYDVQQLEwdEU0xFYXN0MRUwEwYDVQQDEwwxNzIuMTYu 
NS4xMTkxNDAyBgkqhkiG9w0BCQEWJXNoYXduLmxhYnJlY3F1ZUBkaXNjb3Zlcnlz 
b2Z0d2FyZS5jb20wgZ8wDQYJKoZIhvcOCCONSedCgY0AMIGJAoGBAL/Q4iVM+91i 
+vHyBzhSa13W/51nNGPgQhbL+Wb3upKm4ce2vmiW9YN0VpgdC/iiBG9plQ5WjmnE 
TBYWszZCI2jbtxhHDk5NLiEkEvwa4TqJQgqxdS4OBKeQFIQcyc/XQWXr968RLYkG 
OincS/n23ODC/0C9AWTEA2+kcTA3Wea93ePLDSACRRDSCIjDEjIPOuJDJJXJXXUW 
RGlzY292ZXJ5c29mdDAgBgkqhkiG9w0BCQcxExMRY2hhbGxlbmdlcGFzc3dvcmQw 
DQYJKoZIhvcNAQEEBQADgYEAvcVORC+RnXTCGkpvqjKtihBC+oi/3pUMNYlY4Y+I 
60z3jy+mEXwdzVrMWZGM2OIhu2rYD1e1ZcjPnRsee5IaR0PI44fvdbdf3uxLI+vs 
IuAF/CEH03PbapyW0AN3/MGdPseeR2KF3TMMVguqGwBjmiigwFA4HVTrTTWu+SZw 
HQg= 
-----END CERTIFICATE REQUEST----- 
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4. After you request the certificates, wait for a response from the CA.

5. The server certificate will be e-mailed to you by the certificate 
authority. When you receive the e-mail, copy the certificate text from 
the e-mail and paste it into WordPad. Save the WordPad file as 
"cert.pem" and place it in the same folder as your other .pem files.

6. You must also request your CA's CA certificate (also known as an 
intermediate certificate). It is available for download off your CA's Web 
site. If you cannot locate the certificate, phone your CA and have them 
e-mail it to you. This certificate must be in Base64 encoding. If they 
provide it in DER encoding it will not be usable by InteGrade Pro 
Server. Copy the certificate text and paste it into WordPad, save the 
file to the same location as the other .pem files with the name 
"cacert.pem". Include the quotation marks in the name field to prevent 
the default extension from being added to the end of the file name.

Enabling SSL in the InteGrade Pro Server Control Panel 

You have the option to enable SSL functionality on the InteGrade Pro Web 
server. In order to complete this procedure you must have completed the 
procedures above for Generating a Key and a Certificate Signing Request 
and Requesting Certificates from a Certificate Authority. 
Note: The InteGrade Pro Server service must be stopped before any 
changes can be made to your connection setup. Be sure to restart the 
service after making any changes.

1. Using Show Web Server Settings on the Options tab in the InteGrade 
Pro Server Control Panel, select the Enable SSL on this server 
checkbox. 

2. In the Server’s Certificate Location field, type the file name or click the 
browse button and locate the server’s certificate.

3. In the Server’s Key Location field, type the file name or click the 
browse button and locate the server’s key file.

4. In the CA Certificate Location field, type the file name or click the 
browse button and locate the CA’s certificate.

5. In the Password to Unlock the Key field, type the password. This is the 
same password you entered when you created the Certificate Signing 
Request. See Generating a Key and a Certificate Signing Request 
(CSR) on page 74.

Do not delete the certKey.pem or certReq.pem files from your 
system.

http://k12.ncs.com/


The InteGrade Pro Server Control Panel

78  Completing InteGrade Pro Server Configuration Copyright © 1998–2004 Pearson Digital Learning

6. Click OK to temporarily save your changes.

7. To permanently save changes, click OK before exiting the Control 
Panel. To discard all changes, click Cancel on the Configure Web 
Server screen. 

If you clicked OK on the Configure Web Server screen and want to 
discard your most recent changes, click Cancel before exiting the 
Control Panel.

After you complete the SSL required fields, the system checks to 
ensure that certificate files exist in the directories recorded. If the files 
do not exist, you are warned that the file could not be located and the 
Enable SSL on this server checkbox is unselected. 

If the password for the key is invalid, you are warned and the Enable 
SSL on this server checkbox is unselected.

When you open the Control Panel after SSL is enabled, an error 
message is generated if the key and certificate files are not in the 
specified folders. The Provide services to Web clients checkbox is 
cleared.

Completing Password Settings

You use the Common Settings subscreen of the Options tab for controlling 
the required length for passwords, and controlling how and when 
passwords are changed.

The first option in the Passwords group on the Common Settings dialog 
allows you to assign users a password when you create the user IDs 
and then force them to change it the first time they log on. Be sure to 
advise users on proper password creation guidelines.

The second option allows you to set the system so that users can 
change their own passwords. If you do not check this checkbox, the 
system automatically assigns random passwords.

The third item allows you to specify the minimum required length for the 
password. The default minimum is six characters.
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You use the Change Administrator Password subscreen of the Options tab 
of the InteGrade Pro Server Control Panel to change the administrator 
password.

You must remember the administrator password. Record it only if you 
have a secure place to store the recorded password. If you forget the 
administrator password, you must reinstall the InteGrade Pro Server 
software and create a new password. Reinstalling does not overwrite the 
information already entered in the InteGrade Pro Server Control Panel.
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Adding Users to the Control Panel

You can import users from class roster files or add users manually.

Importing Users

You can input users only if your school uses an administration system that 
is capable of exporting class roster information files.

Importing users requires that the gradebook root directory contain teacher 
folders and CL (class roster) files. The root gradebook directory is set up 
on the Options tab of the InteGrade Pro Server Control Panel.

1. Open the InteGrade Pro Server Control Panel and select the Users 
tab.

2. Click Import.

3. Select the Send notification checkbox if you wish to send e-mails with 
user ID and password information to teachers. This only works if the 
teacher's e-mail address is present in the CL file from which 
information is being imported.

4. Select the Create gradebooks checkbox to automatically create a 
gradebook file from the CL file.

The gradebook file is placed in the teacher's directory.

5. Click Import. The system checks the root gradebook directory (for 
example \IGPDATA) for CL files. If no CL files are found, the import 
fails. If they are found, the import proceeds. Be sure to check user 
information when the import is finished. An e-mail is sent to the system 
administrator's e-mail address. It includes a list of all of the user IDs 
and passwords created during the import.

You can also use a pre-defined template gradebook when creating 
teachers’ gradebooks. This allows you to create a gradebook 
containing default classes and spreadsheets. If you wish to use a 
template to create gradebooks, see Creating a Template Gradebook 
and Template Classes on page 13.

If you are configuring the InteGrade Pro Server Control Panel at the 
beginning of the year and teachers are not yet working with a current 
gradebook then it is recommended that you check this option. If 
teachers are already working with gradebooks for the current cycle, 
do not select this option. Be sure however to place their gradebooks 
into their directories once the import is finished.
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Adding Users Manually

Use the following procedure to add users manually to the InteGrade Pro 
Server Control Panel.

1. In Windows Control Panel, open the Server Control Panel.

2. On the Users tab, click Add. The Add User screen appears.

3. In the Full Name field, enter the user's full first and last name.

4. In the Teacher Code field, enter the teacher's code number. This code 
is used to ensure data integrity when data is imported into gradebooks. 
If you are not importing from an administration system, leave this field 
blank.

5. In the User ID field, enter a user ID for this person. This is the user ID 
the teacher uses to log in to the server. The user ID is added to the end 
of the path name shown in the Directory field. This creates a directory 
for storing the user's gradebooks that has the same name as the user 
ID. 

6. In the Password field, enter a user password, or click the Random 
button to assign a password generated by the system.

7. When you created the user ID, the directory path was automatically 
updated to include the user ID. You can change the path name if you 
want. This is the directory where the user's gradebooks will be stored. 
The directory name must be unique for each teacher.

Be sure the Options tab has been completed before you enter users. 
This ensures that when you enter users they receive e-mails containing 
their user ID and password information.

When you first add users to the system you must assign them an 
initial password. This can be one you make up or a system-
generated password. On the Options tab, you can then set the 
system so that the user must change their password the first time 
they log on.

When you create a password and click OK, the password is 
displayed as 5 asterisks (*****), regardless of the actual length of the 
password.

The passwords you create when adding users are e-mailed to users 
provided that you have entered valid e-mail addresses on the 
General tab for each user. If you do not write down the password 
and sending an e-mail notification to the user fails, you must assign 
a new password for the user.
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8. Enter the user's e-mail address. While this field is not required, if you 
enter an e-mail address, notifications can be sent automatically to 
users including information on their new user ID and password.

9. Click Add to add the user and close the screen, or click Add & Stay 
Open if you wish to save this user and add another.

Completing the User Properties Information

Confirm the Information on the General Tab

Double-check the user ID, password, gradebook directory and e-mail 
address information for each user.

Make changes as need to the information on this tab then proceed to the 
User Access tab to set up user access to gradebooks.

If you change the name of the directory where the user's gradebooks are 
stored, you must remember to move any existing files into the new 
directory or the user will not be able to access them.

Setting up User Access to Gradebooks

This procedure is for assigning user access to gradebooks on the network. 
Users can have different types of access to gradebooks. Full access 
allows the user to both view and change data (read-write access). Read-
only access allows the user to view a gradebook but does not permit 
changes.

1. On the Users tab, select a user and click Properties.

2. Click the Access tab. The Access tab displays a list of all users. The 
icons on the right indicate the type of access the current user has to 
the other users' gradebook directories.

3. To ensure a user cannot access other users’ gradebooks, click the X 
beside the user name. To give read-only access, click the glasses. To 
give a user full read-write access, click the notepad.
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In the following example, Julie Hunter has access to other teachers' 
gradebooks as follows: bjsmith–no access, cjohnston–read access 
only, jcarson–read and write access.

4. When finished assigning access, click OK to return to the Users tab.

Creating Bulletins

Use this procedure to create bulletins, which can be viewed by all users 
who connect to InteGrade Pro Server.

1. Open the InteGrade Pro Server Control Panel.

2. Click the Bulletins tab.

3. Click New to create a bulletin.

4. In the Text box, enter the text of the bulletin. There is no limit to the 
amount of text you can enter.
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5. Enter an optional Web page URL. If you enter a URL, the text you 
entered in the Text box appears as a link. When users click it, they are 
directed to the specified URL.

6. The Posting Date and the Show Until dates default automatically to 
today and tomorrow's date. You can change these dates if you want.

7. Select the Delete on Expiry checkbox if you want the bulletin to be 
removed automatically when the Show Until date is reached.

8. Click Create to create the message. The next time users log on they 
will see the new bulletin.

Getting Additional Assistance with Control Panel

Additional detailed procedures for configuring the InteGrade Pro Server 
Control Panel are available in the online help system which is available on 
all screens throughout the InteGrade Pro Server Control Panel.
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Using the SASIxp Software and InteGrade 
Pro Software

This chapter briefly describes the steps required to set up the SASIxp™ 
educational software to exchange data with the InteGrade Pro student 
information software. 
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Introduction
This chapter provides step-by-step instructions for installing the InteGrade 
Pro Data Exchange component into the SASIxp software. It also defines 
the areas in the SASIxp software that need to be set up so the InteGrade 
Pro software can transfer student grading information.

For specific questions regarding the InteGrade Pro software, see the 
InteGrade® Pro User’s Guide Version 9.1 on Customer Link

For more detailed information on using and setting up the SASIxp 
software, see your SASIxp documentation.

System Requirements

For the minimum system requirements for the SASIxp software, see your 
SASIxp documentation. 

Before the SASIxp software can exchange data with the InteGrade Pro 
software, the following must be installed:

SASIxp 3.0 or higher.
InteGrade Pro v4.0 or higher.
The following areas must be defined in SASIxp:
Reporting Periods (Grading Setup atom)
Reporting Options (Grading Setup atom)
Mark Descriptions (Grading Setup atom)
Advanced Options (highest and lowest valid grades for numeric grades 
only) (Grading Setup atom)
Letter grades (Mark Definitions atom)
Verify students are scheduled into classes (Sections atom)
Verify GPAs (GPA Definition atom)
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Before installing the InteGrade Pro Data Exchange component, close any 
other software that is running. Also, the InteGrade Pro Data Exchange 
component must be installed in the same directory where the SASIxp 
software is located.

Installing the InteGrade Pro Data Exchange Component 
If you are running SASIxp software v3.0 or higher, the InteGrade Pro Data 
Exchange component should already exist in your system. Turn on the 
InteGrade Pro Data Exchange atom in the SASIxp 3.0 software (or higher) 
by logging on to the SASIxp software with a new SASIxp 3.0 authorization 
code sheet.
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Setting up the SASIxp Software
The following areas need to be defined for the InteGrade Pro software to 
exchange data with the SASIxp software.

To better understand the setup, use these steps to open the SASIxp 
Grading Setup atom:

1. From the Grade Reporting folder, select the Grading Setup folder.

2. Click the Grading Setup atom.

Defining Reporting Periods

In the Reporting Periods page of the Grading Setup atom, each report row 
represents one End Term spreadsheet in the InteGrade Pro software.

Before each SASIxp reporting period, an ending date becomes a 
collection date for the corresponding End Term spreadsheet in the 
InteGrade Pro software. When you export class rosters from the SASIxp 
software, the export process creates one End Term spreadsheet for each 
SASIxp reporting period for every class.

Reporting Options
In the Reporting Options section, if your school is using letter grades, 
make sure the mark conversion field is set to convert numeric marks to 
letter equivalents. This enables you to specify the percentage cutoff values 
for letter grades in the Mark Definitions atom.

Defining Mark Descriptions

In the Mark Descriptions section, each row represents one grading 
column, plus its associated columns (conduct, comments, absences, etc.) 
in an InteGrade Pro End Term spreadsheet.

In the Alph/Num column, select A to require that grades entered in the 
InteGrade Pro software for that mark are alpha grades, or select N to 
require that grades entered in the InteGrade Pro software for that mark are 
numeric grades.

http://k12.ncs.com/


Copyright © 1998–2004 Pearson Digital Learning Setting up the SASIxp Software  89

Using the SASIxp Software and InteGrade Pro Software

Defining Numeric Grades

If your school collects numeric grades, in the Advanced Options pane, 
type the values in the Highest Valid Grade field and in the Lowest Valid 
Grade field. This determines the range of numeric grades that can be 
entered in the InteGrade Pro software.

Defining Progress Reporting Periods

To create a Progress Reporting End Term spreadsheet, the current 
Progress Reporting period must be defined in the Progress section by 
entering a reporting period number, from the Reporting Periods page, into 
the Periods field.

The Progress Reporting Title defaults to the title from the Reporting 
Periods page. The title may be changed in the Progress section to help 
distinguish the Progress Reporting End Term spreadsheet from the Grade 
Reporting End Term spreadsheets.

In the Alpha/Num field, select A to require that grades entered in the 
InteGrade Pro software for that mark are alpha grades, or select N to 
require that grades entered in the InteGrade Pro software for that mark are 
numeric grades.

On this page you can also determine if Comments, Conduct, Absences 
and Work Habits will be used for the Progress Reporting period. 

Defining Letter Grades

If your school collects letter grades, in the Mark Definitions screen 
(available from the Mark Definitions atom in the Grading Setup folder), 
type values to define your letter grades.

Make sure you have already selected the Convert numeric marks to letter 
equivalent option in the Reporting Option page of the Grading Setup atom, 
described above. This turns on the Mark Cutoff and Mark Value columns 
described below.

1. Type a letter grade value in the Mark column (one letter grade per 
row). 

2. Indicate whether the mark calculates credit.

3. Type a numeric value for Mark Cutoff. For example, entering 92 for the 
A+ mark calculates that a student earning 95% is awarded a letter 
grade of A+.
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4. Type a numeric value for Mark Value. For example, entering 95 for the 
A+ mark calculates that a student earning an A+ is awarded a mark of 
95, even if they were originally awarded the A+ based on an original 
cutoff mark value of 92. 

When you export class roster files to the InteGrade Pro software, these 
conversion values become a grade table in the InteGrade Pro software, 
defining standardized percentage cutoff values for letter grades for all 
teachers importing those class roster files into their InteGrade Pro 
systems.

Verifying Students are Scheduled in Classes
You must have students scheduled into classes to provide the InteGrade 
Pro software with class roster files.

1. Double-click SASI modules.

2. From the Basic Scheduling folder, select the Sections atom.

3. Click the arrows to the right of the Section ID field. Students entered in 
that section of a class display on the screen. 

Defining a GPA
From the Grade Reporting folder, select the Grading Setup folder. Click 
the GPA Definition atom. Complete the screen.
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Exporting from the SASIxp Software
1. Make sure you have a folder or directory created on your network for 

storing InteGrade Pro files for teachers. Pearson Digital Learning 
recommends that you name this directory IGPData. Also, before 
exporting class rosters from the SASIxp software, close down any 
other software that is running.

2. From SASIxp Modules, select the Utilities folder. Select the InteGrade 
Pro Data Exchange atom.

3. Select Export Class Rosters.

4. To export class rosters for all teachers and all grading periods, click 
the All Class Rosters option button and click Export.

If you check the All Reporting Period option button and export for 
teachers who do not have students scheduled in their classes, this 
creates errors during export. However, it does not prevent the process 
from completing.

To export class rosters for a particular teacher or teachers, click the 
Only Class Rosters for these Teachers option button. From the 
Teacher List atom, click a specific teacher and hold down the left-
mouse button to drag the teacher's name into the teacher list in the 
InteGrade Pro Data Exchange screen. When you are finished adding 
teachers, click Export.

To export only selected grading periods, click the Selected Reporting 
Periods option button and make sure Yes displays for each grading 
period to be exported.

To export only the current reporting period, click the Current Reporting 
Periods option button.

To create Progress Reporting End Term spreadsheets, select Include 
Progress and enter a Progress Reporting collection date in the 
Progress Report Date field. Be sure the Progress page of the Grading 
Setup atom is setup correctly before exporting.

5. At the Select the Highest Folder for Export screen, select the IGPData 
folder or the folder you created in Step 1.

6. Click OK to start the export.
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The export process can take several minutes to complete. This process 
creates a CLxxxxxx.GRD file for each teacher in a folder under a school 
folder in the IGPData directory. Do not select a school or teacher folder 
within the IGPData folder.

If a teacher does not have students scheduled in classes, an error 
message displays.

If errors occur during export a message displays, and a log file is created 
in the relevant teacher's folder. If errors occur for more than one teacher, 
look in the file ERRINDEX.LOG in the school folder (under IGPData).
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Working in the InteGrade Pro Software

Importing Class Roster Files
Importing data is the preferred method of adding students and classes to 
your gradebook. Only by importing are you able to electronically export 
data back to the main office at the end of a term.

Importing is often done at the beginning of the school year, but the import 
process can be run at any time. For example, if a large number of students 
transfer into your classes, the main office gives you an import file to update 
your gradebook. The new information is added to your gradebook, but 
existing information is not changed.

You must create the IGPData folder before you can transfer class 
roster and marks data files between the SASIxp software and the 
InteGrade Pro software.

If you are importing to a new gradebook for the first time, use the New 
command from the File menu in the InteGrade Pro software. This 
creates a new gradebook using a class roster file.

If you are importing into an existing gradebook, use the Import 
command from the File menu in the InteGrade Pro software to update 
your gradebook.

For more information, see the InteGrade® Pro User’s Guide Version 9.1 on 
Customer Link.

Reviewing Imported Data 
After importing student and class data, confirm that the data was correctly 
copied into your gradebook. 

You should look for fields that are blank when you know that there should 
be data, or fields that show unrecognizable characters. If you find any 
indication of corrupt or missing data, close the gradebook without saving 
or delete the corrupt data. Begin the import process again with a new file.
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Exporting Marks Data 

1. From the File menu, select Export from Gradebook. Select the 
collection date for which you are exporting grades. Click Next.

2. When prompted to specify where to export the file, select the teacher 
folder labeled with the teacher number. If you cannot see the teacher's 
folder, navigate to that folder then select it. Click Next. 

3. If errors were detected in the data being exported, you can view the 
error log. Errors may cause problems importing the gradebook file into 
SASIxp. These error logs are named ERRORLOG.IMK. They can be 
opened in Notepad (Windows) or SimpleText (Macintosh).
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Importing into the SASIxp Software
If you have not run Update Grades in the SASIxp software, do so at this 
time. This process assures that each student in the Class file has a name 
and place in the Grading file to receive the mark that is transferred in from 
the InteGrade Pro software. 

If you are transferring Progress Reporting marks, Update Progress must 
be run before importing the marks. This process clears the existing 
Progress marks and updates the Progress file with the student's current 
schedule in preparation to receive the marks from the InteGrade Pro 
software.

1. From the SASIxp software, open SASI modules. Click Utilities and 
open the InteGrade Pro Data Exchange atom.

2. From the InteGrade Pro Data Exchange screen, choose the Import 
Marks Data option button. Choose the import options and click Import.

3. To import marks data for all teachers, select the All Marks Data option 
button.

To import marks data for a particular teacher or a group of teachers, 
select the Only Marks Data for these Teachers option button. From the 
Teacher List atom, click a specific teacher and hold down the left 
mouse button to drag the teacher's name into the teacher list in the 
InteGrade Pro Data Exchange screen. 

To import Progress Reporting marks, select Include Progress and 
enter the collection date in the Progress Report Date field. The 
collection date must match the date of the Progress Reporting End 
Term spreadsheet being imported.

4. Set Selected Grading Period to Yes for each reporting period to be 
imported. All other periods should be set to No. To import only the 
current reporting period, click the Current Reporting Periods option 
button.

5. From the Select Highest Folder for Import window, select the IGPData 
folder. Click OK. The following message displays in the lower-left 
corner status bar:

Importing Grades for Teacher xxx
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Verifying Marks Data

To verify that your grades were imported, open the Grade Reporting folder 
and then open the Grading folder. Choose the Class Grades atom, open 
the appropriate class, and view the imported marks data.

To verify that the progress marks were imported, open the Grade 
Reporting folder and then open the Progress folder. Choose the Class 
Progress atom, open the appropriate class, and view the imported marks 
data.
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Working with the ABACUSxp Software
When you import a SASIxp class roster file into the InteGrade Pro 
software, it searches for corresponding ABACUSxp files, provided they are 
both in the same location. The ABxxxxxx.GRD or ATxxxxxx.GRD file must 
use the same teacher code as the CLxxxxxx.GRD file. If the InteGrade Pro 
software finds an ABxxxxxx.GRD or an ATxxxxxx.GRD file, it imports it 
along with the CLxxxxxx.GRD file.

If you do not want the AB or AT files imported with the CL file, you must 
rename or remove these files from the directory.

If the InteGrade Pro software is networked to an administration system, 
there is an automatic import of class roster files. When this occurs, the 
InteGrade Pro software searches for both a CL file and a corresponding 
AB and AT file. the InteGrade Pro software checks the system date/time 
stamp of the files. the InteGrade Pro software imports the files only if the 
date and time are later than the date and time currently stored for the 
gradebook. If the date and time stamp is the same or earlier, the files are 
not imported. A progress bar displays indicating that the gradebook is 
being updated.

When you import an AB file, the InteGrade Pro software takes the 
objectives recorded in the file and displays them and their mastery values 
in the Skill spreadsheet. This spreadsheet can display either a three-level 
objective or a five-level objective.

When you import an AT file, the InteGrade Pro software takes the tests 
recorded in the file and displays them in the Numeric spreadsheet. 

If you import an AB or AT file and do not already have corresponding 
classes in your gradebook, the InteGrade Pro software rejects the records 
and displays an error log file.

Importing ABACUSxp Files into the InteGrade Pro Software

1. From the File menu, select Import into Gradebook. This process uses 
a sequence of screen that help you complete the process.

2. Click Next and follow the instructions on the subsequent screens.

3. Locate the drive and directory containing the import file.

4. Select and open the appropriate file. These files are named 
ABxxxxxx.GRD, where xxxxxx represents your teacher code.

5. Click Import.
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Exporting ABxxxxxx.GRD Files From the ABACUSxp Software

This procedure uses the Print function to export the file to the location you 
specify in Step 6.

1. Open the SASIxp software, then open the Abacus folder.

2. Open the Learning folder, then open the Mastery Reporting atom.

3. In the Report field, select the Class Mastery Export Report.

4. On the Student tab, add Class Sections to the list of sections for which 
to export data.

5. On the Objectives tab, select whether to export three-level or five-level 
objectives, and add objectives for which to export data.

6. On the Options tab in the Path field, enter the location of the highest 
level folder to which you export CLxxxxxx.GRD files using the 
InteGrade Pro Data Exchange atom.

7. To export the ABxxxxxx file, click Report.

8. To print the report, from the Report Setup screen click Print.

The export creates a separate ABxxxxxx.GRD file for each teacher 
assigned to the sections for which you exported. The export places those 
files in the same teacher folders created for the CLxxxxxx.GRD files using 
the InteGrade Pro Data Exchange atom. If the appropriate teacher folders 
do not exist, the ABxxxxxx.GRD file is stored in the specified path.

Exporting ATxxxxxx.GRD Files From the ABACUSxp Software

This procedure uses the Scan function to export the file to the location you 
specify.

1. Open the SASIxp software, then open the Abacus folder.

2. Open the Assessment folder, then open the Test Scoring atom.

3. Select Test ID.

4. Select Test Instructor. This should match that of the CL file. If not, it is 
exported to the specified path, not the individual teacher folder.

5. From the Student Filter, select a section.

6. On the Reports tab, select Reports.

7. On the Options tab, select the correct form and scanner for your site.

8. On the Advanced Options tab, select Create InteGrade Pro File.
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9. Enter the location of the highest level folder to which you export the 
ATxxxxxx.GRD files using the Test Scoring atom.

10. To export the ATxxxxxx file, click Scan, then Scan again.

11. Click Close.

12. At the “Continue Processing Forms” message, click Yes. The file is 
exported to the teacher folder specified in Step 9.
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Using the SASI III Software and InteGrade 
Pro Software

This section describes the steps necessary to install the InteGrade Pro 
Data Exchange component into the SASI™ III software. It also provides a 
brief discussion on how the InteGrade Pro Data Exchange component 
works with the SASI III software.

For more detailed information regarding the InteGrade Pro software, see 
the InteGrade® Pro User’s Guide Version 9.1 on Customer Link.

For more detailed information on using and setting up SASI III, as well as 
minimum system requirements, see your SASI III documentation.
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Setting Up the SASI III Software
These screens are used to set up the SASI III software to run with the 
InteGrade Pro student information software:

RPDCRT (1 and 2)
ATOCRT
IGPCRT (1 and 2)
SEMCRT (contact information including parent's e-mail address)
TEMCRT (for setting up school e-mail information)

Copying Files and Starting the SASI III Software

1. In the IGPro installation folder (which you can download from 
Customer Link), open the SASI3 folder. 

2. From the MS-DOS command prompt, copy the following files to the 
appropriate directories using the DOS copy command.

To the \SASI\DATA directory 
IGPCRT.FRM 
DATABASE.IGP 
XGPCRT.FRM
SEMCRT.FRM
TEMCRT.FRM

To the \SASI\PROG directory 
IGP01.EXE
IGP02.EXE
IGP02P.EXE
IGPCL.EXE
IGPMK.EXE
IGP12.EXE
IGPCRT.EXE 
SEM00.EXE
SEMIDX.EXE

You must use the DOS copy command from a system prompt to 
copy these files. Dragging and dropping files from a CD to a 
directory produces files and programs that are flagged as Read Only 
and these do not function properly in SASI III until the Read Only flag 
is removed.
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SEMCRT.EXE
TEM00.EXE
TEMCRT.EXE

3. Log in to the SASI III software. 

4. From the Enter Command prompt, type DBD00 and press Enter. This 
program updates the database definition file SASIDBD.

5. At the File Code prompt, type IGP. Press Enter. Since only one 
database definition is being updated, press Enter again. At the Are you 
finished prompt, type Y. The database file updates and creates an 
index to the database definition file.

Setting Up RPDCRT
1. At the Enter Command prompt, type RPDCRT and press Enter. Use 

this screen to set up the grade reporting periods from which the 
InteGrade Pro software End Term spreadsheets are created. It must 
be set up prior to exporting data from the SASI III software to the 
InteGrade Pro software at the beginning of the school year.

Make sure that no two-column headings (First Heading and Second 
Heading) are identical. This causes problems with sending grades back to 
the SASI III software.
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2. Type X and press Enter to switch to the second screen. 

3. Under Report Options, type 3 next to Scanner Form. This is a 
requirement for the InteGrade Pro software that enables you to see as 
many students as possible in the RPTSHT lists. These lists are used to 
verify that grades were imported back into the SASI III software. (The 
exception is if the school prints grading scan sheets for any teachers.

Setting Up ATOCRT
1. At the Enter Command prompt, type ATOCRT and press Enter. If the 

ATO file has not been previously created, you will need to run ATO00 
to create the file.

2. Enter the following information on the ATOCRT screen. This 
information sets up the attendance rules for entering attendance data 
into the InteGrade Pro software

Enrollment Information: Grade Level, Minimum Day (in minutes), 
and Max Enrollment (in days) can normally be left to the defaults.
Term Schedule: You need to be sure that at least 2 beginning and 
ending dates are entered. You cannot have only one term defined, 
or 5 terms defined. The valid terms for this section are 2, 3, 4, and 
6 (if needed).
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Bottom Section: This section is used by SASI III Classroom only.

Setting Up IGPCRT
1. At the Enter Command prompt, type IGPCRT and press Enter. Enter 

the following information on the IGPCRT screen. This information sets 
up the validation rules for entering data into the InteGrade Pro 
software.
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Field Description

Incomplete code Enter the symbol you use to designate an 
incomplete assignment or task (for example, 
IN).

Marks required Type Y if you require that marks be entered for 
classes.

Letter/numeric- enter both Type L, N, or B (for both letter and numeric).

Lowest numeric Type the lowest numeric score to allow (for 
example, 001).

Highest numeric Type the highest numeric score to allow (for 
example, 100).

Build Progress Reporting 
End Term Spreadsheets 
with Normal ETS

Type Y to build the progress reporting End 
Term Spreadsheet. If Yes, type up to four 
collection dates. For example, 10/02/01, 12/
11/01, 02/26/02, 08/14/02.

Valid Marks If you specified L or B under Letter/Numeric/
Both, enter the letter grades teachers should 
use under grading standards in the InteGrade 
Pro software (for example, A, A-, B etc.)
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2. When the first screen has been completed, type X and press Enter to 
switch to the second screen.

Type of Grades/Low 
Values

To set up a normal grade table, fill in the first 
column (NOR) with the lowest percentage 
cutoff values for each letter grade in the Valid 
Marks column. 
To set up additional grade tables with different 
cutoffs for the letter grades in the valid marks 
column, enter a heading in the next column, 
and fill in the desired cutoff values for the 
grades shown in the Valid Marks column.

Special Marks Use this area to define special marks the user 
can enter in the InteGrade Pro software to 
allocate specific numeric scores (for example, 
define that entering the symbol CHEAT 
allocates a score of 0, etc.).
In the Symbol column, enter the appropriate 
symbol CHEAT or NHI in the Value column, 
enter the value assigned to the symbol.
If you do not complete this screen, teachers 
can enter any grade information in the 
InteGrade Pro software End Term 
spreadsheet. Also, any data not specified is 
rejected upon import into SASI III.

Field Description
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3. Depending on how you choose to set up your system, review and 
change, if necessary, the settings for Administration Control, and enter 
the codes for the student information listed.

4. Type E and press Enter to end and update this file.

Setting Up SEMCRT

1. At the Enter Command prompt, type SEMCRT and press Enter. This 
information sets up the student contact and e-mail information for the 
InteGrade Pro software.

2. Enter the contact information.

3. Type E and press Enter to end and update this file.

Setting Up TEMCRT
1. At the Enter Command prompt, type TEMCRT and press Enter. This 

information sets up the teacher and school e-mail information for the 
InteGrade Pro software. It also sets up information that will appear on 
reports.

2. Enter the contact information.
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3. Type E and press Enter to end and update this file.
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Exporting from the SASI III Software

Progress Report Files
You must run PCM00 and PCMCRT to create progress comments.

Before you export comment files into the InteGrade Pro software, make 
sure that the COMyxx.dat (where y represents the school year and xx 
represents the school number) file and the PCMyxx.dat file have been 
created and that they contain identical data. 

This is important, since the InteGrade Pro software recognizes only the 
first set of comments exported by the SASI III software. So, if you want to 
export grading comments and you already exported progress comments, 
the InteGrade Pro software does not overwrite progress comments with 
grading comments.

Class Roster Files
The IGP01 program creates a CLxxxxxx.GRD file for each teacher in the 
SASI Data directory. These are the files teachers import into the InteGrade 
Pro software to create their gradebooks. The gradebook contains End 
Term spreadsheets for both progress and grade reporting.

1. At the Enter Command prompt, type IGP01 and press Enter. This file 
exports class roster files from the SASI III software into the InteGrade 
Pro software. Run IGP01 for specific teachers by using the TCH and 
teacher numbers after the program name; for example, IGP01 TCH 
003 005 010.

2. At the Enter Semester Codes from MST to Process prompt, type the 
semester code for the reporting period you want to process (for 
example, 1FY). The import files for the InteGrade Pro software are 
created. The file name for each teacher's class roster file is 
CLxxxxxx.GRD (where xxxxxx represents the teacher number) and it 
is placed in the \SASI\DATA directory.

3. In some cases the, user may choose to alter the directory structure for 
the final location of these CL files. Two programs are provided to 
facilitate this option.

DOS IGPCL, when run at the Enter Command prompt in the SASI III 
software, creates a directory, Igp_data, under the SASI directory and 
within it, a directory for each teacher (\SASI\Igp_data\084). The class 
roster files are automatically copied to the appropriate teacher 
directory. Teachers can access the CL files in this small, personal 
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directory rather than having to read the \SASI\DATA directory. When 
the teacher exports the grades from the InteGrade Pro software, the 
resulting MKxxxxxx.GRD file is placed in the personal directory. 

Since the SASI III software expects to find the teacher's export files in 
the \SASI\DATA directory, a second program is provided to copy all 
MK files from the teachers’ personal directories back to \SASI\DATA. 
This program (DOS command IGPMK) is run from the Enter Command 
prompt in the SASI III software.
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Working in the InteGrade Pro Software

Importing Class Roster Files
1. From the File menu, select New Gradebook, then Create using class 

rosters. Follow the system prompts to create your gradebook.

2. When prompted, name your gradebook and click Save.

3. If errors were detected in the data being imported, you can view the 
error log. These error logs are named ERRORLOG.ICL. Open them in 
Notepad (Windows) or SimpleText (Macintosh).

The ERRORLOG.ICL is always created in the same location that the class 
roster file is imported from. Importing any class roster file from that same 
location always overwrites the ERRORLOG.ICL file in that location. If you 
want to archive the error file, move the file to another location.

Exporting Marks Data Files

See the InteGrade® Pro User’s Guide Version 9.1 for more specific 
information on exporting marks data from the InteGrade Pro software.

1. Prepare the End Term spreadsheet by copying grades from the 
numeric spreadsheet and adding comments.

2. From the File menu, select Export from Gradebook. Select the 
collection date for which you are exporting grades. Click Next.

3. Specify the \SASI\DATA directory when prompted to specify where to 
export the file. Click Next. 

4. If errors were detected in the data being exported, you can view the 
error log. Errors may cause problems importing the gradebook file into 
the SASI III software. These error logs are named ERRORLOG.IMK. 
Open them in Notepad (Windows) or SimpleText (Macintosh).

The ERRORLOG.IMK is always created in the same location that the class 
roster file is imported from. Importing any class roster file from that same 
location always overwrites the ERRORLOG.IMK file in that location. If you 
want to archive the error file, move the file to another location.
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Exporting Attendance Data

The IGP01.EXE program in the SASI III software collects attendance data 
from SASI III (ATD, ATP, ATS, ATC, ATR and ATO files). Whether or not 
your school plans to use this feature, you need to create and configure 
these files before you run IGP01 for the first time.

This feature is not intended to replace SASI III Classroom, but provides 
another means of processing attendance data.

When the teachers create their gradebooks, they contain an attendance 
spreadsheet showing a complete attendance calendar for the school year. 
You can enter absence reason codes for each student (providing the ATO 
file is properly configured). The teachers can use or view data, or send it 
electronically to the administration system for later transfer to the 
attendance files. 

Teachers can export their attendance data at any interval (period, daily, 
and so on). 

1. From the attendance spreadsheet in the InteGrade Pro software, click 
the column heading for a particular day and select Export This Day's 
Attendance. 

This creates or appends to an attendance export file (AXnnn.GRD, 
where nnn equals the teacher number) and writes this file to the 
\SASI\DATA directory.

2. The office runs the IGP12.EXE program to post the teachers 
attendance data to either the ATP or ATD attendance file.
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Importing into the SASI III Software

Preparing to Import the Marks Data Files
1. In the RPDCRT program, set the Current Grade Reporting Period field 

to the reporting period for which you want to import marks data.

2. From the Enter Command prompt, type RPT00 and press Enter. This 
program should only be run at the end of each reporting period before 
importing marks data from the InteGrade Pro software for that specific 
reporting period. Depending on the grade reporting period entered, 
you may or may not see all of the following prompts.

3. At the Enter Grade Report Period (1-6) prompt, enter the appropriate 
grade reporting period (for example, 4).

4. At the Allow Duplicate Courses in RPT file prompt, type N for no 
duplicate courses. If you type Y, make sure that in the CRSCRT file, 
the User Code 2 field has an X in the first position

5. At the Retain RPT Records for Inactive Students? prompt, type Y or N.

6. At the Refresh Credit in RPT with Credit from MST? prompt, type Y or 
N.

7. At the Using 9999 as T/A CRS Number, Using 0.25 as T/A CRS Credit, 
prompt, type Y to continue or N to abort.

8. At the Enter Command prompt, type RPT01 and press Enter. This 
creates a new grade sheet file. This file needs to be run every time 
after RPT00 is run.

Importing Marks Data – Grade Reporting (RPT)
To import grading and progress information from the InteGrade Pro 
software:

1. For report or grading information, type IGP02 at the Enter Command 
prompt. This file imports the marks data or MK file from the InteGrade 
Pro software into the SASI III software. Run IGP02 for specific 
teachers by using the TCH and teacher numbers after the program 
name; for example, IGP02 TCH 003 005 010.

2. Make sure you have created a progress file (PRG00) for the current 
marking period.

http://k12.ncs.com/


Copyright © 1998–2004 Pearson Digital Learning Importing into the SASI III Software  115

Using the SASI III Software and InteGrade Pro Software

3. Enter the appropriate quarter (1-5). At the Creating a new progress 
report file for quarter 4. OK to proceed Y/N prompt, enter Y. A progress 
file and an index are created.

4. At the Enter Command prompt, type PRG01 and press Enter. This 
creates a new progress sheet file. This file needs to be run after every 
PRG00.

5. For progress information, type IGP02P and press Enter at the Enter 
Command prompt.

For more information regarding either progress or grading files, see your 
SASI III documentation.

Verifying Marks Data
1. At the Enter Command prompt, type RPTSHT and press Enter. 

2. Type G (G = Get Sheet) and type the teacher code (for example, 002) 
in the TCH field, and type the period number (for example, 1) in the 
PER field. Press Enter.

Viewing Error Reports

No error reports are written when data is exported from the SASI III 
software to the InteGrade Pro software. However, error reports can be 
created when importing an InteGrade Pro file (MKxxxxxx.GRD) into the 
SASI III software. There are two ways to view these error reports:

DBPRNT, which prints a report
DBSAVE, which creates a P file for later viewing

To view these error reports, you must run either DBPRNT or DBSAVE 
before running IGP02.
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Using CIMS (iSeries 400) Software and 
InteGrade Pro Software

This section describes the InteGrade Pro Data Exchange programs in the 
CIMS® SMS™ (Student Management System) on the IBM® e™ Server 
iSeries 400 mid-range computing system.

You use the CIMS / InteGrade Pro Data Exchange programs to copy class 
and student information into a class roster file. Then you export the file to 
the personal computer on which you run the InteGrade Pro software. After 
converting the file into multiple teacher files on the personal computer, you 
import the information into the InteGrade Pro software as teacher 
gradebooks.

After the teachers update their gradebooks, you convert the grading and 
attendance information for these class rosters into one file on the personal 
computer and import it back into the SMS software on the IBM iSeries 400 
system.

See The CIMS (PC) Software and InteGrade Pro Software for information 
about using the CIMS / InteGrade Pro file conversion programs on the 
personal computer.
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Technical Requirements
Before you begin working with the InteGrade Pro software, you need to 
install the following software.

On the personal computer:
InteGrade Pro 9.1 software
CIMS III/InteGrade Pro File Converter (IGPCNV32.EXE from the 
InteGrade Pro installation folder)
A file transfer and router program; for example, Client Access for 
Windows

On the IBM iSeries 400 system:

IBM iSeries 400 Operating System, Version 4, Release 3 or higher
CIMS III ACS™ (Application Control System), Release 3.01 or higher
CIMS III Student Applications, Release 8.01 or higher
A file transfer and router program; for example, Client Access

For specific questions about using the InteGrade Pro software, see the 
InteGrade® Pro User’s Guide Version 9.1 (IGPUSER.PDF), located on 
Customer Link. 
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Invalid Characters
You must not use the following characters when creating district or school 
definitions for the InteGrade Pro software:

/ \ ~ ` ! % ^ & * ( ) - + = { } [ ] : ; " ' ? |

The following characters are valid:

. _ @ # $
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Overview of the Data Exchange Process
The data exchange process begins in the CIMS III SMS software. The 
system compiles student, class, attendance, and grading information into 
the single data file PSTU607C as member CLdissch, where dis represents 
your district code and sch represents your school code.

If you are using Client Access and have the IBM program PC Organizer 
(PCO) active, the system can download this data file automatically to the 
personal computer as CLdissch.CIM. Otherwise, you must use your 
chosen file transfer software.

Using the file converter provided with the InteGrade Pro software, you 
convert the data file into separate files named CLxxxxxx.GRD, where 
xxxxxx represents the teacher code. A teacher then imports a file labeled 
with his or her teacher code into the InteGrade Pro software to create a 
new gradebook or update an existing gradebook.

After all teachers export grade data files from their gradebooks, the 
converter compiles the MKxxxxxx.GRD files into a single data file named 
MKdissch.CIM, where dis and sch are the district and school codes. You 
upload this file to the IBM iSeries 400 system, to the SMSTRANS library in 
file PSTU607M as member MKdissch. Then you can edit and post the new 
information to student information records, replacing the existing 
information in the SMS software.

After all teachers export attendance data files from their gradebooks, the 
converter compiles the AXxxxxxx.GRD files into a single data file named 
AXdissch.CIM, where dis and sch are the district and school codes. You 
upload this file to the IBM iSeries 400 system, to the SMSTRANS library in 
file PSTU607M as member AXdissch. Then, you can edit and post the 
new information to student information records, replacing the existing 
information in the SMS software.

The figure on the next page illustrates the data exchange process
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Programs Used in Data Exchange
To transfer information between the CIMS III student software and the 
InteGrade Pro software, use the following SMS programs from the 
SMS820: InteGrade Pro Data Exchange Programs menu.

GRD.255 – Define Incomplete Symbol

GRD.240H – Define Validation Rules

GRD.270H – Define Grade Tables

GRD.290H – Define End Term Spreadsheet

STU.607 – Download Class Roster Files to InteGrade Pro

STU.608 – Upload Marks Data from InteGrade Pro

GRD.620P – Edit and Post Marks Data from InteGrade Pro

GRD.630E – Correct InteGrade Pro Edit Failures and Post

GRD.520 – InteGrade Pro Edit Failures Report

GRD.950 – Purge InteGrade Pro Edit Failures

STU.609 – Upload Attendance Data from InteGrade Pro

GRD.621P – Edit and Post Attendance Data from InteGrade 

Use these instructions to familiarize yourself with the data exchange 
programs or when you have a question that the online help does not 
address.

While in the programs, read the online help text if you need more 
information about using a field or screen.
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Defining the Incomplete Symbol
Use GRD.255 – Define Incomplete Symbol to designate the symbol for an 
incomplete grade. The InteGrade Pro software uses this symbol to 
indicate the absence of a score on a required task. You can designate only 
one incomplete symbol for use with the InteGrade Pro software.

Select the GRD.255 – Define Incomplete Symbol option from the SMS820: 
InteGrade Pro Data Exchange Programs menu.

Type A in the command field, your district code, and your school code. 
When you press Enter, the system displays the following screen where 
you can choose a symbol from the valid values that you defined in 
GRD.250 – Grade Symbols.

Choosing the Incomplete Symbol

1. In the Incomplete Symbol field, type the code that your school uses to 
indicate that a student did not complete a class.

2. Press Enter to return to the command screen.
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Defining the Spreadsheet's Validation Rules
Use GRD.240H - Define Validation Rules to control how teachers can 
enter comment, grade, and absence information in the InteGrade Pro 
software.

You select the type of rule (comment, grade, or absence), whether the 
information is required, and the numeric range or specific characters that 
are acceptable. After you define validation rules, you can apply them to 
specified columns that appear in the InteGrade Pro spreadsheet.

Select the GRD.240H – Define Validation Rules option from the SMS820: 
InteGrade Pro Data Exchange Programs menu.

Type A in the command field, your district code, school code, and the rule 
ID you want to define. When you press Enter, the system displays the 
following screen where you can define the rule.

Defining Spreadsheet Rules

1. In the Description field, type a brief description.
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2. Follow the instructions for the type of rule that you are defining:

To define a letter grade rule, type Y in the Letter field and N in the 
Numeric field. Indicate whether the grade is required in the 
Required field.
To define a grading absence or numeric grade rule, type N in the 
Letter field and Y in the Numeric field. Indicate whether the grade is 
required in the Required field. You also need to set the minimum 
and maximum limits for the grade in the Minimum Value and 
Maximum Value fields.
To define an alphanumeric grade rule, type Y in both the Letter and 
Numeric fields and indicate whether the grade is required in the 
Required field. You also need to set the minimum and maximum 
limits for the grade in the Minimum Value and Maximum Value 
fields.
To define a comment rule, type Y in the Comments field and 
indicate whether a comment is required in the Comment Required 
field. A comment validation rule does not control the contents of the 
comment column.

3. If you want the system to edit the data entry for a grade rule, leave Y in 
the Verify Minimum and Maximum Value Against Grade Symbols? 
field.

For example, use the Y value if you are defining a numeric grade rule 
that you want the system to validate against the specified minimum 
and maximum values. Be sure you have defined all of the values from 
the minimum through the maximum value in GRD.250 – Grade 
Symbols.

Otherwise, type N in this field (such as when you define a grading 
absence rule).

4. Press Enter.

For a letter grade, the system displays the following screen where you 
can define the acceptable values for the letter grade rule.

For any other type of rule, the system displays the command screen.
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Specifying Acceptable Values for Letter Grade Rules

1. In the Letter Grade field, type a grade for this rule. Press Enter to add 
another grade.

2. When you finish entering letter grades, press Enter again to display the 
following line command screen.
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Using Line Commands to Modify Spreadsheet Rules

1. In the CMD field, type a valid command from the list of commands at 
the bottom of the screen.

2. When you finish working with the letter grade rules, type E in the CMD 
field and press Enter to return to the command screen.
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Defining the Grade Tables
Use GRD.270H – Define Grade Tables to define up to nine different 
grading levels, such as honor grades and remedial grades, and the grades 
associated with each level. Grades relate to the course ID, which identifies 
the grading level that should be used for the course.

Select the GRD.270H – Define Grade Tables option from the SMS820: 
InteGrade Pro Data Exchange Programs menu.

Type A in the command field, your district code, school code, and the 
grade table ID you want to define. When you press Enter, the system 
displays the following screen where you can define the grade table.

Defining Grading Levels

1. In the Description field, type a brief description of the grade table.

2. Press Enter to display the following screen where you can enter the 
grades associated with this level and set the lowest numeric limit for 
each grade.
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Specifying Acceptable Values for Grade Tables

1. Type a letter in the Letter Grade field and the lowest acceptable limit 
for this letter grade in the Lower Limit field.

The lowest numeric limit relates to percentages; for example, an A 
grade may not be lower than 90%.

2. Press Enter to add another grade and its associated lower limit.

3. When you finish entering grades for this grade level, press Enter again 
to display a line command screen.

4. Use the line command screen to work with the grade table. When you 
finish, type E in the CMD field and press Enter to return to the 
command screen.
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Defining the Spreadsheets
Use GRD.290H – Define End Term Spreadsheet to define the 
spreadsheets used by the InteGrade Pro software for collecting grading or 
attendance information.

You can define one spreadsheet for each reporting period, or one 
spreadsheet for each date you expect teachers to export grades or 
attendance data from the InteGrade Pro software.

Select the GRD.290H – Define End Term Spreadsheet option from the 
SMS820: InteGrade Pro Data Exchange Programs menu.

Type A in the command field, your district code, school code, and the 
spreadsheet ID you want to define. For example, type QT1 to represent 
the first quarter reporting period. When you press Enter, the system 
displays the following screen where you can define the spreadsheet.

Defining an End Term or Attendance Spreadsheet

1. Type a title for the spreadsheet in the Name field.

2. If you are defining a grading spreadsheet, type the date when the 
grading information will be collected in the Collection Date field. You 
must type the year as shown on the screen, including slashes: YYYY/
MM/DD; for example, 2000/06/01.
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3. If you are defining an attendance spreadsheet, type Y in the 
Attendance Spreadsheet field. Then either type the range of dates to 
use for the attendance information in the Calendar Dates From and 
Thru fields, or type a term number in the Or Term field. For a 
spreadsheet covering a single day, type the same date in the From 
and Thru fields.

4. Press Enter to display the following screen where you can define the 
grading columns in the spreadsheet.

If you are working with an existing grading end term spreadsheet, and 
entered Y to create an attendance spreadsheet, the system displays an 
error message when you press Enter. To correct this, you must define a 
new spreadsheet for the attendance data.

Defining the End Term Spreadsheet Columns

You do not need to define columns for attendance data.

1. In the Column Number field, type the number of the spreadsheet 
column.

The column number represents the column position; for example, 
column number 1 is the first column in the spreadsheet. You can use 
decimals to indicate that a column should fit between two other 
columns.
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2. Type the task type (C = comment, G = grade, or A = absence) in the 
Task Code field and the task identifier in the Spreadsheet Task ID 
field.

If you are adding an Absence task, the system displays the Grade Title 
for Absence prompt for the absence grade title, after you press Enter.

3. Type the name of the task in the Task Name field and, if applicable, the 
spreadsheet validation rule for this column in the Validation Rule ID 
field.

Column headings are limited to two rows of seven characters in the 
InteGrade Pro software. The system abbreviates anything larger than 
seven characters in each row to fit the available space.

4. Press Enter to add the column to the spreadsheet.

5. When you finish adding columns, press Enter again to display the line 
command screen.

6. Use the line command screen to work with the spreadsheet columns. 
When you finish, type E in the CMD field and press Enter to return to 
the command screen.
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Downloading Class Roster Data from CIMS III
Use STU.607 – Download Class Roster Files to the InteGrade Pro 
software to create a file that contains class roster data from the SMS 
software.

The system stores the CLdissch data file (where dis and sch are the 
district and school codes) in SMSTRANS/PSTU607C.

If you have Client Access for Windows installed on a personal computer 
and the IBM iSeries 400 system, with PCO (PC Organizer) active, the 
system can complete the transfer process automatically. Otherwise, you 
must transfer the file to the personal computer as CLdissch.CIM, using 
your chosen file transfer software.

This section describes how to download the class roster information with 
PCO active, as well as how to create the class roster file when PCO is not 
active.

After the data transfer, you must convert the CIMS data file for each school 
into separate teacher files using the personal computer program, CIMS III/
InteGrade Pro File Converter. See The CIMS (PC) Software and 
InteGrade Pro Software for information about this converter.

Select the STU.607 – Download Class Roster Files to the InteGrade Pro 
software option from the SMS820: InteGrade Pro Data Exchange 
Programs menu.
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Starting the Download with PCO Active

1. In the Process for fields, type the district and school codes for the 
information you want to download.

2. Type Y in the Do You Want to Create Files? field if you want to create 
the download file. Type N if you previously created the file and now 
want to download it from the IBM iSeries 400 system to the PC.

3. If you want the system to download the file automatically, type Y in the 
Do you Want to Download Files Now? field. Otherwise, type N in this 
field.

The system displays this field only when PCO is active.

4. When you press Enter, the system displays the following prompt 
screen where you can limit the download information to a specified 
teacher and cutoff date.
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Downloading the Class Roster File

You must use GRD.290H – Define End Term Spreadsheet to define a 
spreadsheet with at least one task for the specified school before you 
run this program.

1. To restrict the download to one teacher, type the teacher name in the 
Limit to Teacher field.

2. To restrict the download to students currently scheduled in the class, 
type a date in the Exclude Drops Before this Date field. This date 
represents the last date that a student can drop the course and still be 
eligible for a grade. The system excludes from the download all 
students who dropped the class before this date.

If you have not defined the spreadsheet and task, the system displays 
a warning message and prompt field. Type Y in the Cancel Download 
to Set Up the Spreadsheet? prompt field if you want to leave this 
program and define a new spreadsheet.

Type N in this field if you want to download the class roster information 
without a defined spreadsheet. If you type N, you cannot upload 
grades and attendance data from the InteGrade Pro software back to 
the SMS software for these class rosters.
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3. If PCO is active, after you press Enter the system displays a 
submission screen where you can specify the file name and PC drive 
designation.

4. When you press Enter, the system checks for existing file names and if 
found, displays a Do you wish to overwrite the existing member? 
prompt. Type Y if you want to continue and write over the existing file 
or N if you want to cancel.

Creating the Download File with PCO Inactive

Select the STU.607 – Download Class Roster Files to the InteGrade Pro 
software option from the SMS820: InteGrade Pro Data Exchange 
Programs menu.

1. In the Process for fields, type the district and school codes.

2. Type Y in the Do You Want to Create Files? field if you want to create 
a file to download later.

If you did not activate PCO before running this program, you can 
create the file but the system cannot download the file automatically. 
You must download the file later.
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If you choose not to create the file now, type N in the Do You Want to 
Create Files? field and press Enter, or press Cancel. After canceling 
the program, you can start PCO by typing the STRPCO command at 
an IBM iSeries 400 system command line. Then, you can run this 
program again with PCO active.

3. If you choose to create the file now, after you press Enter the system 
displays the prompt screen where you can limit the download 
information to a specified teacher and drop date.

4. When you press Enter, the system checks for existing files. If it finds a 
file with the same name, the system displays a prompt to overwrite the 
file. Type Y if you want to continue, or N if you want to cancel.
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Uploading Grading Data from the InteGrade Pro 
Software

If you have Client Access for Windows installed on the IBM iSeries 400 
system and a personal computer, with the IBM PCO program active, you 
can use this interactive program to upload your InteGrade Pro grading 
data to the IBM iSeries 400 SMS software. The system uploads the 
grading marks file, MKdissch.CIM (where dis represents the district code 
and sch represents the school code), from the root directory of the 
personal computer.

Ensure that the MKdissch.CIM file is stored in the root directory of the 
personal computer before you attempt to run this program.

If you use a different file transfer software, you must transfer the marks file 
manually to the SMSTRANS library as file PSTU607M, member 
MKdissch.

Select the STU.608 – Upload Marks Data from InteGrade Pro option from 
the SMS820: InteGrade Pro Data Exchange Programs menu.

Note: Administrators with InteGrade Pro Server can generate marks files 
directly from the gradebooks saved on the server.

Uploading the Marks File
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1. In the Process for fields, type the district and school codes for the file 
you want to upload.

2. If PCO is active, after you press Enter the system displays a 
submission screen where you can specify the file name and PC drive 
designation where the upload data resides.

If PCO is not active, the system displays a file library prompt. Type Y in 
the Do You Want to Create Files Library for Use in Later Upload? field 
and press Enter if you want to create a file to upload later.

3. After you press Enter, the system checks for existing file names and if 
found, displays a Do you wish to overwrite the existing member? 
prompt. Type Y if you want to continue and write over the existing file 
or N if you want to cancel.
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Editing and Posting the Grading Data
Use GRD.620P – Edit and Post Marks Data to check data uploaded from 
the InteGrade Pro software. The system compares the data with the 
validation rules that you set up in the SMS software.

Select the GRD.620P – Edit and Post Marks Data from InteGrade Pro 
option from the SMS820: InteGrade Pro Data Exchange Programs menu.

Type the district and school codes for the file that you want to post. When 
you press Enter, the system displays the following screen where you can 
choose to replace grading, comment, or absence data. You also must 
specify whether absences are considered excused or unexcused for 
grading purposes.

Editing and Posting the Grades

1. If you want to post the updated information and write over any existing 
information, type Y in the appropriate fields:

Replace Existing Grading Information?

Replace Existing Comment Information?

Replace Existing Absence Information?

If you do not want the system to replace the designated type of 
information, type N in the field.
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2. If you want to treat grading absences as excused, type E in the 
Absences Are Excused or Unexcused? field. Otherwise, type U to treat 
absences as unexcused for grading purposes.

3. When you press Enter, the system displays the error summary screen.

Reviewing the Error Summary

1. Note the number of records with errors in the Items in Error field. After 
reviewing the summarized error data, you can choose to print an edit 
failures report or correct the edit failures now.

2. To print the report that lists the edit failures, type Y in the Print Edit 
Failures Report? field. When you press Enter, the system displays a 
submission prompt.

3. To correct the edit failures, type Y in the Correct Edit Failures? field. 
When you press Enter, the system calls GRD.630E – Correct 
InteGrade Pro Edit Failures and Post, which displays each record that 
failed the edit checks.

4. If you choose N for both of these fields, the system returns to the menu 
when you press Enter.
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Correcting and Posting the Edit Failures
Use GRD.630E – Correct InteGrade Pro Edit Failures and Post to correct 
any data uploaded from the InteGrade Pro software that failed edits in the 
GRD.620P program, then post the corrected records to the SMS software.

Select the GRD.630E – Correct InteGrade Pro Edit Failures and Post 
option from the SMS820: InteGrade Pro Data Exchange Programs menu.

Type the district and school codes for the file you want to correct. When 
you press Enter, the system sequentially displays the records that contain 
edit failures.

Correcting the Edit Failures

1. To delete this record, type Y in the Mark to Remove? field. Otherwise, 
type N in this field.

2. If necessary, change the spreadsheet identifier in the Spreadsheet ID 
field and the task identifier in the Spreadsheet Task ID field.

3. If necessary, change the type in the Grade Type field.

4. If you want to replace the existing data in the SMS software with the 
updated information in this record, type Y in the Replace Existing 
Data? field. Otherwise, type N in this field.

5. If this information relates to a required grade, type Y in the Required 
Grade Data? field. Otherwise, type N in this field.

http://k12.ncs.com/


Copyright © 1998–2004 Pearson Digital Learning Correcting and Posting the Edit Failures  143

Using CIMS (iSeries 400) Software and InteGrade Pro Software

6. When you press Enter, the system corrects the record and posts the 
corrected information to the SMS software. Then, the system displays 
the next record that failed edit.

Once you correct a record, it no longer appears in the edit failure 
report.

7. When you finish correcting edit failures, type 3 and press Enter to 
return to the menu.
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Running the InteGrade Pro Edit Failures Report
Use GRD.520P – InteGrade Pro Edit Failures Report to produce a report 
of failed data items from the InteGrade Pro software.

Select the GRD.520P – InteGrade Pro Edit Failures Report option from the 
SMS820: InteGrade Pro Data Exchange Programs menu.

Printing the Records that Failed Edit

1. Type the district and school codes for the report.

2. If you want to sort the report by a specified group, type 1 under the 
Sort field next to the desired field; for example, Teacher.

3. If you want to limit the report to a specified group, type a specific code 
next to the desired field; for example, type a valid spreadsheet 
identifier in the Spreadsheet ID field.

4. If you want the pages to break before a change in the specified sort 
field, type Y in the Page Break field.

For example, to break pages in the report for each different teacher, 
select Teacher in the Sort field and type Y in this field.

5. When you press Enter, the system displays a submission prompt.
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Purging the InteGrade Pro Edit Failures
Use GRD.950P – Purge InteGrade Pro Edit Failures to remove records 
from the edit failure file that cannot be corrected or that you decide not to 
correct.

Select the GRD.950P – Purge InteGrade Pro Edit Failures option from the 
SMS820: InteGrade Pro Data Exchange Programs menu.

Deleting the Records that Failed Edit

Use this program with caution. You cannot retrieve records after you purge 
them.

1. In the Process field, type the district and school codes for the file you 
want to purge.

2. To limit the purge to a specified spreadsheet or task, type the identifier 
in the Spreadsheet ID or Task ID field.

3. Press Enter. The system deletes the records and returns a count of the 
purged records.
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Uploading Attendance Data from the InteGrade Pro 
Software

If you have Client Access for Windows installed on the IBM iSeries 400 
system and a personal computer, with the IBM PCO program active, you 
can use this interactive program to upload your InteGrade Pro attendance 
data to the SMS. The system uploads the attendance file, AXdissch.CIM 
(where dis represents the district code and sch represents the school 
code), from the root directory of the personal computer.

Ensure that the AXdissch.CIM file is stored in the root directory of the 
personal computer before you attempt to run this program.

If you use a different file transfer software, you must transfer the 
attendance file manually to the SMSTRANS library as file PSTU607M, 
member AXdissch.

Select the STU.609 – Upload Attendance Data from InteGrade Pro option 
from the SMS820: InteGrade Pro Data Exchange Programs menu.

Uploading the Attendance Data File
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1. In the Process for fields, type the district and school codes for the file 
you want to upload.

2. If PCO is active, after you press Enter the system displays a submittal 
screen where you can specify the file name and PC drive designation 
where the upload data resides.

If PCO is not active, the system displays a file library prompt. Type Y in 
the Do You Want to Create Files Library for Use in Later Upload? field 
and press Enter if you want to create a file to upload later.

3. After you press Enter, the system checks for existing file names and if 
found, displays a Do you wish to overwrite the existing member? 
prompt. Type Y if you want to continue and write over the existing file 
or N if you want to cancel.
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Editing and Posting Attendance Data
Use GRD.621P – Edit and Post Attendance Data to check data uploaded 
from the InteGrade Pro software. The system compares the data with the 
validation rules that you set up in the SMS software.

Select the GRD.621P – Edit and Post Attendance Data from InteGrade 
option from the SMS820: InteGrade Pro Data Exchange Programs menu.

Type the district and school codes for the file that you want to post. When 
you press Enter, the system automatically runs the update. If any errors 
occur during the update, the system prints an error report.

There are ten possible errors:

No course request (a student had a reported absence in a course he or 
she has not requested).
Request exists, but the reported absence is not within the add/drop 
date range.
District ID is not valid.
School ID is not valid.
Spreadsheet ID is not valid.
Student ID is not valid.
Period number is blank.
Period is not defined.
Absence already exists.
Record code read in is not equal to 620.

You must correct any errors in the InteGrade Pro software, reconvert the 
data, and then upload the corrected data into the SMS software.
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Software

This section describes the CIMS III/InteGrade Pro software file conversion 
programs, which run on the personal computer.

You use the CIMS III to InteGrade Pro file conversion program to convert 
the class roster file from the CIMS III SMS™ software into several files for 
use by the InteGrade Pro software on the personal computer.

You use the InteGrade Pro to CIMS III file conversion program to convert 
multiple marks or attendance files from the InteGrade Pro software into 
one file for use by the CIMS III SMS software on the IBM iSeries 400 
system.
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System Requirements
Before you can transfer data between the InteGrade Pro software and the 
CIMS III student software, you should verify that you can transfer files 
between your IBM iSeries 400 system and your PC. For more information, 
see the documentation for your communications software.

If you are using Client Access to communicate to a PC, you may be able to 
run this process directly from the CIMS III software. For more information, 
See Using CIMS (iSeries 400) Software and InteGrade Pro Software.

For specific questions about using the InteGrade Pro software, see the 
InteGrade Pro User’s Guide Version 9.1, available on Customer Link.

The following software programs must be installed:

InteGrade Pro 9.1 software on a personal computer
IBM iSeries 400 Operating System, Version 3 Release 2 (or higher)
A file transfer and router program, for example, Client Access for 
Windows
CIMS III ACS™ (Application Control System), Release 3.00.01 (or 
above)

See the Application Control System User's Guide for more information 
on installing and implementing the ACS software.

CIMS III Student Applications, Release 7.00 (or higher)

You must install and implement the SMS™ (Student Management System) 
software before you can install and operate the other student software. 
Other student software exchanges information with the SMS software, 
which enables you to automate activities in the areas of student 
scheduling, attendance, and grading.
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File Conversion Process
The InteGrade Pro software provides a converter tool to convert the 
CLdissch.CIM file (where dis and sch represent your district and school 
codes). The system converts the file into CLxxxxxx.GRD files (where 
xxxxxx represents the teacher code), which you then can import into the 
InteGrade Pro software.

The converter also creates a folder hierarchy for the files within a location 
that you specify. This hierarchy consists of a school folder named after the 
CIMS III school ID. It contains one teacher folder, named after the teacher 
code for each teacher within that school. Each teacher folder contains the 
CLxxxxxx.GRD file for that teacher. The teacher imports this file into the 
InteGrade Pro software.

After updating grades, the teacher exports a MKxxxxxx.GRD file to the 
same location. The converter compiles all MKxxxxxx.GRD files into a 
single MKdissch.CIM file, which you can upload into the CIMS III student 
software.

The teacher can also export attendance data by exporting an 
AXxxxxxx.GRD file to the same location. The converter compiles all 
AXxxxxxx.GRD files into a single AXdissch.CIM, which you can upload 
into the CIMS III student software.

This converter resides and operates on the personal computer.

Setting Up the File Converter
Open the CIMS folder in the InteGrade Pro installation folder (which you 
can download from Customer Link). The ADMIN/CIMS folder contains the 
IGPCNV32.EXE file for Windows 98, Windows 2000 or Windows XP. 
Copy the file to your personal computer.

http://k12.ncs.com/


The CIMS (PC) Software and InteGrade Pro Software

152  Converting a CIMS III File into InteGrade Pro Files Copyright © 1998–2004 Pearson Digital Learning

Converting a CIMS III File into InteGrade Pro Files
1. Open the file converter. The system displays the transfer method 

selection screen.

2. Select the CIMS III to InteGrade Pro option.
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3. Click Next. The system displays the following screen.

4. In the Convert CIMS III files (CLxxxxx.CIM files) from: field, type the 
location of the CLdissch.CIM file. You can click the ellipsis button to 
browse for the file, if necessary.

5. In the Create class roster files in: field, type the location of the folder in 
which you want the new folders created.

6. Click Convert. The conversion process creates a subfolder for the 
school that contains subfolders for each teacher in the school. The 
teacher folders each contain a CLxxxxxx.GRD file, which you can 
import into the InteGrade Pro software.

http://k12.ncs.com/


The CIMS (PC) Software and InteGrade Pro Software

154  Converting InteGrade Pro Files into One CIMS III File Copyright © 1998–2004 Pearson Digital Learning

Converting InteGrade Pro Files into One CIMS III File
You can convert either marks or attendance data from the InteGrade Pro 
software.

Note: Administrators with InteGrade Pro Server can generate marks files 
directly from the gradebooks saved on the server.

Converting Marks Data
1. Open the file converter. The system displays the transfer method 

selection screen.

2. Select the InteGrade Pro Marks to CIMS III option.
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3. Click Next. The system displays the file location screen.

4. In the first field, type the location of the folder that contains the school 
and teacher folders with the MKxxxxxx.GRD files.

5. In the second field, type C:\. This step creates the MKdissch.CIM file in 
your root directory.

If you use the automatic upload process in the CIMS III student 
software, this file must be located in your root directory.

6. Click Convert. The conversion process runs.

When the process completes, you can transfer the resulting 
MKdissch.CIM file to the CIMS III student software.
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Converting Attendance Data

1. Open the file converter. The system displays the transfer method 
selection screen.

2. Select the InteGrade Pro Attendance to CIMS III option.
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3. Click Next. The system displays the file location screen.

4. In the first field, type the location of the folder that contains the school 
and teacher folders with the AXxxxxxx.GRD files.

5. In the second field, type C:\. This step creates the AXdissch.CIM file in 
your root directory.

If you use the automatic upload process in the CIMS III student 
software, this file must be located in your root directory.

6. Click Convert. The conversion process runs.

When the process is finished, you can transfer the resulting MKdissch.CIM 
file to the CIMS III student software.
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Using the OSIRIS Software and InteGrade 
Pro Software

This section provides brief instructions for generating and sending class 
lists to the InteGrade Pro software, receiving and processing grade files 
from the InteGrade Pro software, and viewing grade file errors. 

For more specific instructions on using the InteGrade Data Exchange 
module for data exchange data between the Osiris software and the 
InteGrade Pro software, see the Osiris Data Exchange User Guide.
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Introduction
Before using the InteGrade Pro software, you must transfer all the teacher, 
student, and roster information from the Osiris software to the InteGrade 
Pro software. The Export Rosters from Osiris to InteGrade option sets up 
this information for transfer.

With the InteGrade Administrator software, you can also transfer student 
grades from the InteGrade Pro software to the OSIRIS® software. OSIRIS 
can then use the information to calculate GPA and other grade 
information.

Creating Teacher Directories on a Hard Disk
Each teacher using the InteGrade Pro software on a hard disk must have a 
subdirectory in the \INTEGRD directory. The teacher's InteGrade Pro data 
files are stored in this subdirectory. 

If the InteGrade Pro software is accessible to OSIRIS, a subdirectory is 
automatically created when you send class lists to the InteGrade Pro 
software using the InteGrade Data Exchange. If the InteGrade Pro 
software is not accessible to the OSIRIS software, you should create 
subdirectories on the hard disk where the InteGrade Pro software is 
installed for each teacher using that disk.

Overview of Using InteGrade and OSIRIS

When using the OSIRIS software and the InteGrade Pro software 
together, you must complete the following steps:

1. Set up all the teacher, student, and roster information in the OSIRIS 
software. See the guide entitled OSIRIS: Getting Started for more 
information.

2. Change the InteGrade field in the Teacher Information screen from N 
(No) to Y (Yes) for each teacher who uses the InteGrade Pro software.

3. Transfer the data from the OSIRIS software to the InteGrade Pro 
software before using the InteGrade Pro software.

4. Transfer the grades from the InteGrade Pro software to the OSIRIS 
software after a grade reporting period.

If you change any of the configuration information such as the comment 
codes, after you transfer rosters to the InteGrade Pro software, the 
InteGrade Pro data will be incorrect.
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Setting Up OSIRIS
Complete the following steps to set up the OSIRIS software so that you 
transfer information to and from the InteGrade Pro software.

1. Set up the student, teacher, and roster information in the OSIRIS 
software. See sections 3–7 of your OSIRIS Database User's Guide for 
more information about setting up student, teacher, and roster 
information.

2. Display the Teacher Information screen.

3. From the OSIRIS main menu, type 1 and press Enter to select the 
Database Editor option.

4. From the Database Editor main menu, type 2 and press Esc to select 
the Teacher Information option. The Teacher Information menu then 
displays.

5. Display a teacher. If necessary, change the sort order.

The sort order, displayed after the Order field in the box at the top of 
the screen, is the criterion by which the teacher records are ordered for 
display. You can order teachers by last name or ID number. 

To change the current sort order, press 9 (9ORDER). The sort order 
changes each time you press 9.

6. Display the teacher. Use any of the methods below.

Press 1 (1FIND). When the system prompts with Enter teacher to 
find, type in an ID number or the first few characters of a last name 
and press Enter. If you enter a valid ID, the teacher's record is 
displayed. If the ID does not exist, the record for the next teacher 
ID displays. If you enter a name, a list of teacher names appears. 
Use the Up and Down arrow keys to highlight the teacher and 
press Enter. The teacher's record displays.
Press 3 (3PRIOR) or 4 (4NEXT) to display the previous or next 
teacher according to the sort order. You can also press the Up and 
Down arrow keys to display the previous or next teacher.
Press Home or Enter to display the first or last teacher according to 
the sort order.

7. Change the InteGrade field to Y.

Press 2 (2EDIT).
Use the Up and Down arrow keys to move the cursor to the 
InteGrade field.
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Type Y and press Enter. If you type Y (Yes) in the InteGrade field 
and print grade scan sheets, a scan sheet will not print for that 
teacher.

8. Press Ins to accept the changes you made or press Esc to cancel the 
changes.

9. Press Esc twice to exit the Teacher Information menu and return to the 
OSIRIS main menu.

After you have set up the OSIRIS teacher, student, and roster information, 
the OSIRIS software places this information into individual files so the 
information can be used with the InteGrade Pro software. Use the 
Exporting Rosters from OSIRIS to InteGrade option to select the 
information you want to transfer and export it to the InteGrade Pro 
software.

Enter information into fields to determine the roster information to be sent 
from OSIRIS to the InteGrade Pro software.
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Exporting Teacher Rosters to the InteGrade Pro 
Software

When the roster information is being transferred from the OSIRIS software 
to the InteGrade Pro software, a file is created that lists the teachers 
whose rosters were exported. 

Selecting Teachers

Complete the following steps to select teachers for whom you will transfer 
the roster, student, and teacher information into the InteGrade Pro 
software.

1. From the System Administrator Main Menu, press 9 and then Enter to 
select the InteGrade Administrator option. The InteGrade 
Administrator menu is displayed.

2. Press 1 and then Enter to select the Export Rosters from OSIRIS to 
InteGrade option. The Export Rosters from OSIRIS to InteGrade 
screen is displayed.

3. Press T (Teachers) to display the list of teachers.

4. Select the teachers whose roster information you want to transfer to 
the InteGrade Pro software.

To select individual teachers from the list, use the Up and Down 
arrow keys to highlight the teachers and press S to select the 
teacher. The following symbol (") appears next to the teacher's 
name that you select. This symbol marks the teachers to be 
included in the list to transfer. Press S again if you want to remove 
the symbol.
To select all the teachers at once, press M (Markall). The (") 
symbol appears to the left of every teacher's name.

5. Press Enter to accept all the teachers you have marked. Nine teachers 
are listed on the screen. If more teachers are marked than what can be 
displayed on the screen, ellipses (...) are displayed after the last 
teacher.

Specifying the Effective Dates and Path
With the F2 (2EDIT) command, you can change the effective dates for 
transferring roster information and the DOS path to which the information 
will be transferred. Complete these steps to change the dates and path.
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1. Specify the effective dates. Press 2 (2EDIT). The cursor moves to the 
first date in the Roster Effective Dates field.

Type the first date in the MM/DD/YY format.

Use the Tab, Shift+Tab, Enter, or Up and Down arrow keys to move to 
the end date field.

Type the end date in the MM/DD/YY format, use the Tab, Enter, or Up 
and Down arrow keys to move to the path field.

2. Type the path, up to 40 characters, to which you want to send the 
roster information, for example, C:\INTEGRAD. Once you export the 
rosters, each roster is copied into a subdirectory under each teacher's 
number, for example, C:\INTEGRAD\123456.

3. After you change the Effective Dates and Path field, press Ins to 
accept the changes, or press Esc to cancel.

If you press Ins, the changes you made are accepted and you are 
ready to transfer the roster information.

If you press Esc, the Transfer Rosters from OSIRIS to InteGrade 
screen displays the way it was before you pressed 2 (2EDIT).

Exporting the Class Rosters

After determining the information that you want to transfer to the InteGrade 
Pro software, transfer the data as follows.

1. Verify the teacher, effective dates, and path information. Make sure the 
fields are set correctly for the information you want to transfer.

2. Press P (Proceed). The Printer Information screen appears on the 
screen. When you transfer rosters, a report is created so that you can 
see the teachers whose files were exported.

Press the Tab, Shift+Tab, Enter, or Up and Down arrow keys to move 
from field to field, and enter the necessary information. 

3. Press the Ins key. A status box appears on the screen that counts the 
teachers, their classes and students as they are processed and 
displays the teacher being processed.

If you use a disk drive as the path, the software verifies that there is 
enough room on the disk for the necessary information. If there is not 
enough room, the following message appears on the prompt line:

Disk is full, insert a new disk. Press C to continue 
or <ESC> to cancel.
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4. When the process is complete, the following message appears on the 
prompt line:

Process complete. Press ESC.

Press Esc three times to return to the System Administrator main 
menu.
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Importing Grades From the InteGrade Pro Software to 
the OSIRIS Software

Before you can compute grades using the Grade Reporter module, you 
must move the grades from the InteGrade Pro software to the OSIRIS 
software. Once the information is transferred to the OSIRIS software, the 
office can compute grades, create report cards, and update transcripts. 
You use the Import Grades from the InteGrade Pro software to OSIRIS 
screen to specify the information to transfer.

The Grade Import from InteGrade Pro Verification Report

When grade information is being transferred from the InteGrade Pro 
software to the OSIRIS software, a file is created listing errors that 
occurred during the transfer and any data that changed information 
previously stored in OSIRIS.

Specifying the Effective Path
Use the 2 (2EDIT) command to specify the DOS path from which the 
grade files will be transferred. This path must be the DOS path where the 
InteGrade data fields are located, normally the InteGrade Pro directory.

1. From the System Administrator Main Menu, press 9 and then Enter to 
select the InteGrade Administrator option.

2. Press 2 and then Enter to select the Import Grades from InteGrade Pro 
to OSIRIS option. The Import Grades from InteGrade to OSIRIS 
screen is displayed.

3. Press 2 (2EDIT). Type the path, up to 40 characters, to which the 
InteGrade Pro grade information was sent, for example, 
C:\INTEGRAD, and press Enter.

If the path you specified does not contain grade information, then the 
Selected Teacher list is empty. You cannot proceed until you find the 
correct path or data has been exported out of the InteGrade Pro 
software. 

If the path is correct and contains grade information, you can proceed 
to selecting teachers from the InteGrade Teachers list, as explained 
next.
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Selecting Teachers

Choose the teachers whose class grades you want to transfer. Complete 
the steps listed below and on the next page.

1. Press T (Teachers) letter command to get a list of teachers using the 
InteGrade Pro software.

2. Use the Up and Down arrow keys to highlight the teachers whose 
grades are transferred.

3. Press the S to select the teacher. The following symbol (") appears 
next to the teacher name that you select. This symbol marks the 
teachers to be included in the list to transfer. Press S again to remove 
the symbol.

4. Continue marking all the necessary teachers.

5. Press Enter to accept all the teachers that you have marked. Five 
teachers are listed on the screen. If more teachers are marked than 
what can be displayed on the screen, ellipses (...) are displayed after 
the last teacher.

Selecting Grades to Transfer
The Grades command lets you select the grade information to be 
transferred. Complete the steps listed below to select the grade 
information.

1. To display the list of grade items, press G (Grades) to get a list of valid 
grade information defined in the OSIRIS software.

2. To select the grade items, use the Up and Down arrow keys to 
highlight the grade items that you want to transfer.

3. Press the S to select the grade. The (") appears next to the period that 
you select. This symbol marks the grade items to be included in the list 
to transfer. Press S again to remove the symbol.

4. Continue marking all the necessary grades items.

5. Press Enter to accept all the grade items that you have marked. Five 
grades are listed on the screen. If more are marked than what can be 
displayed on the screen, ellipses (...) are displayed after the last grade.
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Transferring Grades

After determining what information you want to transfer to OSIRIS, use P 
(Proceed) to transfer the data. Complete the following steps to transfer 
grades from the InteGrade Pro software to OSIRIS.

1. Verify the teachers, grade periods, and path that you want to import to 
the OSIRIS software.

2. To transfer the grades, press P (Proceed). The Printer Information 
screen appears. When you transfer grades, a report is created so that 
you can see if any errors occurred or if any information in OSIRIS was 
changed.

3. Press Tab, Shift+Tab, Enter, or Up and Down arrow keys to move from 
field to field, and enter the necessary information.

4. To start the transfer, press Ins. The status box counts the number of 
grades as they are processed and displays the current teacher whose 
grade information is being processed.

If there is not enough room, the following message displays on the 
prompt line:

Disk is full. Insert a new disk. Press C to continue 
or <ESC> to cancel.

If no grade information exists in the path, the following message 
displays:

No teacher or grade information was found in the 
specified path. Press ESC.

If you have not selected at least one teacher, the following message 
displays:

You cannot import until you specify teachers. Press 
<ESC>. 

Press Esc and press T (Teachers) to select teachers.

5. When the process is complete, the following message displays on the 
prompt line:

Process complete.

Press Esc three times to return to the System Administrator main 
menu.
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Using the TSS/TESS Software and 
InteGrade Pro Software

This section provides instructions for generating and sending class lists to 
the InteGrade Pro software, receiving and processing grade files from the 
InteGrade Pro software, and viewing grade file errors.
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Introduction
The InteGrade Pro software works with The School System™/The 
Elementary School System™ (TSS/TESS) software during the year:

InteGrade Data Exchange transfers class lists and student 
demographic data to the InteGrade Pro software. Class lists are 
transferred regularly at the beginning of a school semester, and as 
required due to class list changes. This data is sent to each teacher's 
subdirectory or data disk.

During the term, teachers use the InteGrade Pro software to record 
student scores, and to calculate grades and class averages for each of 
their classes. The InteGrade Pro software also prints analysis reports.

At the end of each report period, teachers prepare an End Term 
spreadsheet report and use the InteGrade Export Report Card data 
function to export the end term data.

For more specific instructions on using the InteGrade Pro Data Exchange 
module to exchange data between the TSS software and the InteGrade 
Pro software, see The School System, Volume Two, Chapter 24, 
"Exchanging Data with InteGrade." 

About InteGrade Data Exchange
The InteGrade Data Exchange function is the administration system side 
of the interface between The School System and InteGrade Pro student 
information software. It enables the transfer of data between the 
administration system and the InteGrade Pro software.

You can use the InteGrade Data Exchange module to:

Generate and send class lists to the InteGrade Pro software

Receive and process grade files from the InteGrade Pro software

View grade file errors

Each of these tasks is a function on the InteGrade Data Exchange main 
screen. 
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Setting Up TSS

Specifying Computers and Types of Users
Use this option to specify what type of computers the teachers are using, 
and whether they are local or remote users.

If there are a combination of local and remote users on DOS-compatible 
computers and remote users on Apple computers, you must process each 
type of user separately. Use Setup to switch between each type of user.

1. From the InteGrade Data Exchange menu, select 8 (Setup).

2. Select the version of the InteGrade Pro software being used, and 
follow the appropriate instructions.

Apple - type 1
IBM or Mac - type 2, and then the setup parameters:

Type 1 if users are local and data is transferred electronically. Type 2 if 
data is transferred using disks.

If you select 1, you must specify the drive where the InteGrade Pro 
software is installed. If the InteGrade Pro software is installed on the 
local drive, the drive used for data exchange is usually C. If the 
InteGrade Pro software is installed on a network server, specify the 
appropriate network drive.

If you select 2, you must specify the drive letter indicating a disk drive, 
for example, A:\ or B:\.

Defining Extra Columns for the End Term Spreadsheet

If you want to use more columns than are currently defined for the End 
Term spreadsheet, you need to predefine them in TSS. You must label 
these columns with an appropriate header, as the InteGrade Pro software 
does not show unnamed columns.

You define mark columns for TSS in the Academic Progress module by 
selecting Academic Progress Parameters (define mark types) directory. 
You define mark columns for TESS in the Grade Reporting module by 
selecting the School Parameters directory. These mark types display in 
the End Term spreadsheet.
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Exporting Class List Files to the InteGrade Pro 
Software

Selecting Teachers

From the main menu, select InteGrade Data Exchange. Eight functions 
are listed at the top. Most of the InteGrade Data Exchange functions 
process data by teacher. The screen contains the following information:

Field Description

Teacher The teacher code and name for each teacher.

Class List Export The status of the class list export for each 
teacher (showing the semester in the column 
heading). There are five status categories:

Blank: the teacher’s class lists have not 
been generated for the semester (not 
selected when generating the class lists).
Generated: the teacher’s class lists have 
been generated for the semester but they 
have not yet been transferred to the 
InteGrade Pro software.
No Classes: an attempt was made to 
generate the teacher’s classes, but there 
were none.
Sent: the teacher’s class lists have been 
transferred to the InteGrade Pro software 
but they were not deleted from the user 
subdirectory. (See Delete Files.)
Deleted: a teacher's class lists were 
deleted from the user subdirectory.
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In most of the InteGrade Data Exchange functions, selecting the teachers 
to include also selects the data to process. These functions contain a 
Change Selection of Teachers option.

Type 1 to select all teachers, and then confirm the selection. Entering 
Y sets all Y/N indicators on the display form to Y.

Type 2 to select specific teachers. All Y/N indicators on the screen 
default to N. For each teacher to select, enter the teacher code, shown 
in the left column. The Y/N indicator for the teacher changes to Y. 
Press Esc and then Enter when you are finished.

Type 3 to change the selection for individual teachers.

Grades Import The status of the grade data received for each 
teacher (showing the report period in the 
column heading). There are five status 
descriptions:

Blank: grades have not been received 
from the InteGrade Pro software for the 
selected teacher.
Ready: the teacher’s grades export file is 
ready to be received (this is indicated only 
when the InteGrade Pro software is 
installed on a hard disk that is accessible 
to the user subdirectory).
Received: a teacher’s grades have been 
received from the InteGrade Pro software, 
but they have not been processed.
Processed: teacher’s grades have been 
processed, but they have not been deleted 
from the hard disk.
Deleted: a teachers grades have been 
deleted from the hard disk.

The comment “Errors” is added to the status 
description when errors occur.

Y/N Column Y if the teacher is selected for processing, or 
N if the teacher is not (displayed in 
subsequent menus).

Field Description
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Type the teacher code for each teacher whose selection is changed. The 
teacher's name displays. Type Y to select the teacher, or N to deselect the 
teacher.

Generating Class List Files

This function generates class lists for downloading to the InteGrade Pro 
software.

1. From the InteGrade Data Exchange menu, select 1 (Generate Class 
Lists). This generates class lists for downloading to the InteGrade Pro 
software.

2. Type the semester number for which to generate class lists.

3. At the prompt:

Type 2 to select teachers. Initially, select only teachers with a blank 
or No Classes in the Class List Export column.
Type 1 to generate the class lists for selected teachers, then Y to 
confirm the selection.

After the process is complete, the main menu displays. Select InteGrade 
Data Exchange. The Class List Export column displays one of the 
following for each teacher listed:

Generated – indicates the teacher's class lists have been generated 
for the current semester.

Blank – indicates that class lists have not been generated for those 
teachers, because they were not selected when generating the class 
lists.

If No Classes appears in this column for teachers who do have 
classes, check the Master Schedule directory and the students 
schedules, and make corrections as required.

Then repeat option 1 (Generate the Selected Teachers Class Lists), 
using the default selection of teachers (teachers whose class lists 
have not been generated and who now have classes).

Warning: If you make changes to the Master Schedule or to the 
students' schedules, you must rerun the Generate Class List process for 
all teachers before you can send class lists to the InteGrade Pro 
software.
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Sending Class Lists to the InteGrade Pro Software

This function sends generated class list files to the InteGrade Pro 
software. 

1. From the InteGrade Data Exchange menu, select 2 (Send Class Lists 
to InteGrade Pro).

2. At the prompt:

Type 2 to select teachers. Initially, only teachers with Generated in 
the Class List Export column are selected.

Type 1 to send the class lists, then Y to continue.
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Importing Grade Files from the InteGrade Pro Software
This function transfers marks data from the InteGrade Pro software to the 
TSS/TESS software. For specific instructions on exporting data from the 
InteGrade Pro software to TSS/TESS, see the School System, Volume 
Two, Chapter 24, "Exchanging Data with InteGrade," pages 24-18 to 24-
20.

1. From the InteGrade Data Exchange menu, select 3 (Receive Grade 
Files from InteGrade).

2. Enter the report period for which to receive grades. Type Y to confirm 
the entry if prompted to do so. If the specified report period is not the 
same as the current report period, the system deletes any grade files 
and updates the current report period in InteGrade Data Exchange.

Viewing Grade File Errors
This function displays errors in the grade files. To display errors, enter the 
teacher code for those teachers with errors in the Grades Import column. It 
checks for errors that have prevented grades from being transferred 
successfully to the TSS/TESS software from the InteGrade Pro software, 
and produces a list of errors to enable teachers to correct their InteGrade 
Pro files.

1. From the InteGrade Data Exchange menu, select 4 (View Grade File 
Errors)

2. Type the code of a teacher for whom to display errors. Read the 
information on the screen, and press Enter to continue. Repeat for 
each teacher to display.

Errors may be one or more of the following:

Blank course numbers.

Blank or nonnumeric section numbers, report period or student 
numbers.

Incorrect course section numbers. The source of this error may be on 
the Master Schedule directory or the teacher's InteGrade Pro file.

There are no records for one or more of the teacher's classes.

Warning: Do NOT process grade files until all errors are corrected or 
substantiated. Otherwise, incorrect information is entered into the TSS/
TESS software.
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Report period numbers not matching the InteGrade Data Exchange's 
current report period.

When you process the grade files, you may find more errors. Report 950 – 
Student Edit list displays these errors.

You can correct errors in the TSS/TESS software using the Marks Input 
function, or by having teachers use the InteGrade Pro software. If teachers 
correct the errors, classes with grade file errors must be:

Corrected by the teacher (using InteGrade Pro).

Placed onto Export Data disks (using InteGrade Pro).

Transferred to the office computer.

Verify grades by printing Report 820 – Marks Gathering Forms and 
distributing them to teachers for verification of grades. If there are errors, 
correct the grades manually using the Marks Input function in the 
administration system.

Processing Grade Files
Use this function to process the corrected grade files. The grade files for 
the selected teachers merge into a single file.

Processing grade files updates the TSS/TESS database and prints Report 
950 – Student Edit List. This report identifies any errors or inconsistencies 
in any grade file that prevented the database from being correctly updated.

When you use this function, there should be no teachers with “Received” 
(Errors) in the Grades Import column.

1. From the Data Exchange menu, select 5 (Process Grade Files).

2. Type 2 to select teachers. Initially, teachers with “Received” in the 
Grades Import column are selected.

3. Type 1 to process the grade files, then type 1 to confirm the selection. 
Turn on the printer.

When the process is complete, “Processed” displays in the Grades Import 
column.

If Report 950 – Student Edit List shows numerous errors for any teacher, 
compile a list of errors for each teacher and have that teacher make 
appropriate corrections to their InteGrade Pro files. Then receive, view and 
process the files for these teachers again (options 3, 4, and 5 on the 
InteGrade Data Exchange screen).
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Utilities

This chapter includes information on utilities and extra component 
information available for the InteGrade Pro software.
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Forms Scanning and the InteGrade Pro software

Supported Scanners and Forms
Forms scanning is available in Windows environments only. The following 
NCS Pearson, Inc. scanners are supported: 

OpScan® 2, 3, 4, 4XP, 4U, 5, 6, 7, 8, 10, or 21 scanners
OpScan iNSIGHT™ 2 and 4 scanners (connected RS-232)
OpScan 2, 3, 4, 4XP, 4U scanners with the SelfScore® option
OpScan 9010M scanner
OpScan 9020M

The following standard NCS Pearson SelfScore Forms can be scanned:

94746 – 200W test sheet
95141 – 25/25 test sheet side
95142 – 50/50 test sheet side
95676 – 40/W test sheet
95677 – 100W test sheet
95679 – 100/100 side test sheet
95945 – 50 W/W test sheet
95946 – 50/W test sheet
95947 – 50W/50W test sheet side
96569 – E25/W test sheet
98253 – E25 test sheet
98255 – 50 test sheet
106173 – 100 test sheet

Scanner Hardware Support and Supplies

For information on scanner support or supplies, contact Pearson Digital 
Learning at http://customerlink.pearsondigital.com/contact.asp.

Sentry® 3000 series and OpScan 3000 and 4000 series scanners are 
not supported.
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Directory Structure Created

Installation of the InteGrade Pro student information software takes the 
contents of the C:\Program Files\NCS Pearson\ScanTools II directory and 
copies it to IGPRO directory. These files are described below.

Directory Files Description

\IGPRO Roboex32.dll
ScanToolls II.cnt
ScanTools II.exe
ScanTools II.hlp
ST2_res.dll
ST2Gen.dll
ST2Gen_res.dll
ST2Slk.dll
ST2Slk_res.dll

ScanTools II run-time scanning 
module executable files. 

\IGPRO\Applications Znnn.sds ScanTools II reserved folder for 
application files (required). At least 
one appdef “z” file must be 
present in this folder. Place all 
ScanTools II applications used by 
InteGrade Pro in this folder.

\IGPRO\Data *.dat ScanTools II reserved folder for 
data files (required). Data files are 
created to contain document data; 
the data file is overwritten when a 
new batch from the same 
application starts to scan.

\IGPRO\Profiles *.$cp
*.$ep
*.$sp

ScanTools II reserved folder for 
conversion, edit, and score 
profiles. (This folder is required 
even if no profiles are present.)    
Place all the ScanTools II profiles 
used by the end-user’s application 
(i.e. InteGrade Pro) in this folder.
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Master Password Generator
You can use the Master Password Generator (MPG) to override a 
teacher's password to obtain access to that teacher's gradebook file. 

Authorizing the Master Password Generator
To authorize the MPG, you need a different authorization code from the 
one used to authorize the InteGrade Pro software. Call Pearson Digital 
Learning Technical Support at (800) 736-4357 to obtain an authorization 
code for the MPG. 

Security Risks

There are certain security risks to using the MPG. Anyone with access to 
the MPG can create a master password for any InteGrade Pro installation 
at your site. You should keep the MPG program as secure as possible and 
should never install it or copy it to the InteGrade Pro directory.

Passwords
If you forget your master password, contact Pearson Digital Learning 
Technical Support at http://customerlink.pearsondigital.com/contact.asp 
for assistance.

Running the InteGrade Pro Master Password Generator:

To install the MPG:

1. In the IGPro installation folder (which you can download from 
Customer Link), open the ADMIN/PASSWORD folder.

2. Copy the MPG program file to a secure location on your computer. For 
security reasons, do not copy the files to the same location as your 
InteGrade Pro software.

These instructions are generic for Windows and Macintosh. Differences 
between platforms have been noted.
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To run the MPG:

Note the following when using Master Password Generator: 

You must have access to the network where both the administration 
system and the InteGrade Pro software are located.

Before you can run the MPG you must obtain an authorization code 
from Pearson Digital Learning Technical Support at (800) 282-4490.

1. Open the MPG program and enter your licensee name, site number, 
and authorization code. Click Next.

2. In the MPG Password field, type your password

3. In the Confirm Password field, retype your password to confirm it. Click 
Create (for Win) or OK (for Mac). The Master Password Generator 
screen displays. 

There are two tabs, MPG Security (used to set or change the password for 
running the MPG) and InteGrade Pro Master Password (used to set/
change a password for accessing teacher gradebooks).

To create an InteGrade Pro master password:

1. From the InteGrade Pro Master Password tab, type a new master 
password in the New Master Password field.

2. In the Confirm New Master Password field, retype your password to 
confirm it.

3. Click Save Password File. Be sure you save the password file in the 
same location where you installed the InteGrade Pro software.

4. To close the MPG screen, click the X in the upper-right corner (for Win) 
or click the Close box (for Mac).

To change your Master Password Generator password:

1. In the MPG Security tab, type your password in the Existing MPG 
Password field. Click OK.

2. In the Enter your new MPG password field, type your new password. 
Click OK.

This is the password for running the Master Password Generator in 
the future. It is not the password you use to access teacher 
gradebooks.
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3. In the Confirm your MPG password field, retype your password to 
confirm it. Click OK.

4. Click OK when the message "Your MPG password has been updated" 
displays.

5. To close the MPG screen, click the X in the upper-right corner (for Win) 
or click the Close box (for Mac).

When you set a master password for the InteGrade Pro software, the MPG 
sets the master password into an encrypted MPG key file that contains the 
administrator's master password, as well as site and product verification 
information. The key file is cross-platform and may be copied and used in 
the InteGrade Pro directory on Windows and Macintosh.

The MPG key file must be in the same directory as the InteGrade Pro 
software. When you run the InteGrade Pro software from a location that 
also contains the MPG key file, you can open a password-protected 
gradebook file. If you remove the key file from the InteGrade Pro directory, 
the master password will not work. Entering the master password 
bypasses the gradebook file's password.

The MPG is site-specific. The MPG is licensed to a school site and can 
generate a master password for all gradebooks within that site. Your 
school site can obtain authorization for an MPG for your currently licensed 
InteGrade Pro platform(s), Windows or Macintosh.

Thereafter you can set up your master password or change either the 
MPG password or your master password at any time. Your master 
password is the one you use to open password-protected gradebooks. 
However, for the master password to open the gradebook file, the file must 
have been saved in an InteGrade Pro software authorized to the same site 
as the MPG.

If you are already running the InteGrade Pro software while setting a 
master password, you must close and then reopen the InteGrade Pro 
software for the master password to work.
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Uninstalling the InteGrade Pro Server Software
Use the following procedure to uninstall the InteGrade Pro Server 
software. You can uninstall all other components of the InteGrade Pro 
software using the regular Macintosh and Windows uninstall utilities.

1. Shut down the InteGrade Pro Server service. This is done through the 
Administrative Tools icon in the Control Panel. See your Windows 
operating system documentation for detailed instructions on how to 
shut down a server.

2. Open Control Panel and use the Add/Remove Programs option to 
remove the InteGrade Pro Server software.

3. Restart the computer.

If you wish to keep your data repository, stop now.

4. Delete all remaining files from the \Program Files\NCS 
Pearson\InteGrade Pro Server directory.
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Copyright

Portions of this software are Copyright (c) 1993 - 2001, Chad Z. Hower (Kudzu) and the Indy Pit Crew - http://
www.nevrona.com/Indy/ License

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met:·Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation, about box and/or other materials provided with the distribution.

No personal names or organizations names associated with the Indy project may be used to endorse or promote 
products derived from this software without specific prior written permission of the specific individual or organization.

THIS SOFTWARE IS PROVIDED BY Chad Z. Hower (Kudzu) and the Indy Pit Crew "AS IS'' AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL 
THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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